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1. About Breeze 
 

Breeze, Multiple Stream Media Processor, is a software tool operating with streams of 
video, audio and pictures. It may play, record, convert, replay back and forth video 
sequences, view and edit images, operate media devices within local computer, via 
local intra net and the Internet.  

User interface of Breeze allows managing media (video / audio) streams, individual 
images and media devices similarly, in a simple intuitive and uniform fashion. You 
can step back and forth through the sequences of video, audio or images, play them 
back and forth, compare them side by side, capture and save images of your choice 
"on the fly" or save all of them. Think about Breeze as about several "video books of 
pictures" you can thumb and scroll back and forth at once.  

For business users Breeze is a unique and effective tool for a side by side, 
comparative analysis of video, audio and images, in the number of areas such as 
professional sport, security, scientific, medical, video and photo editing applications, 
etc.  

Breeze supports 100+ video, audio and image formats including AVI, MPEG-1, MPEG-
2, MPEG-4, VOB, WMV, ASF, FLV, MOV, DV, H.264, DivX, XviD, OOV, MP3, WMA, 
WAV, JPEG, JPEG-2000, PNG, GIF, TIFF, BMP, 50+ YUV / YCbCr formats.  
 
Breeze also supports the following media devices (video, audio): Webcams, Digital 
Video Camcoders (DVCAM), Video Cassette Recorders (VCR), TV tuners, FM radio 
tuners, microphones and other audio capture devices.  

 

To receive latest news about Breeze, to download most recent upgrades of Breeze 
packages, to read extended Breeze help and FAQ (Frequently Asked Questions), to 
download additional support documentation, visit Breeze support web site 
www.DiscoveryBiz.Net. 

 

You may contact Breeze support via e-mail: support@DiscoveryBiz.net.  
Breeze support web site:    www.DiscoveryBiz.Net. 
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2. Overview of Breeze 

Breeze editions 
There are three main editions of Breeze: 

Breeze 
Light 

Edition 

Basic set of features  
 
Able to processes multiple streams  
 
Basic set of features associated with assistant 
channel of steaming document. 

Free 

Breeze 
Standard 
Edition 

Full set of features  
 
Able to processes multiple streams  
 
Full set of features associated with assistant channel 
of steaming document. 

Free to try 
for 30 days 

Breeze 
Professional 

Edition 

Professional set of features 
 
Processes up to 4, 8, 16, 32 steaming channels  
 
Custom versions processes up to 1024 channels, 
depending on configuration  
 
Professional set of features associated with assistant 
channel of steaming document. 

Free to try 
for 30 days 
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Breeze offers several groups of functions.  Table 1 compares core features in the 
different editions of Breeze. 

 

Table 1. 

 Breeze 
Light  

Breeze 
Standard  

Breeze 
Professional  

View images  √ √ √ 

Slide show √ √ √ 

Play image or video sequence forward or / 
and backward. √ √ √ 

Record image or / and video sequence.  √ √ √ 

Individual capturing images from video 
sequences.  √ √ √ 

Exchange of images between any of Breeze 
video ports and clipboard, back and forth.  √ √ √ 

Zoom image operations  √ √ √ 

Opening input image of video file or / and 
stream via file manager with preview 
image window  

√ √ √ 

Saving images from any video port of 
Breeze to the graphical file via file manager 
with preview image window  

√ √ √ 

Number of processed streaming documents Multiple Multiple Multiple 

Number of processed steaming channels in 
the streaming document 1 2 2 

Custom number of channels    up to 1024 
Synchronous playing, recording and 
processing of image or video sequences in 
the primary and assistant channels back 
and forth in the same or opposite 
directions  

 √ √ 

Regulated “on the fly” speed of playing, 
recording, processing  √ √ √ 

Fast “on the fly” synchronous / 
asynchronous reversing of play direction  √ √ √ 

Basic image processing functions  √ √ √ 

Full set of image processing functions   √ √ 

Advanced professional set of image 
processing functions  

  √ 

Custom set of user interface, application 
and image processing features  

  √ 
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Breeze main window 
Breeze main window includes the following user interface components:  
 

• Title bar  
• Main menu  
• Toolbars  
• Status bar 
 

 
 
Title bar displays names of open input documents (files, video streams, images etc.).  

Main menu provides an access to the majority of commands available in Breeze. 
Most frequently used commands are also available in the pop-up menus invoked by 
the clicking the right button of a mouse.  

Toolbars is another handy way to access Breeze commands. All commands supported 
by toolbars are also available in the main menu.  

Status bar is used to display text information about current state of a browser 
window, menus, toolbars etc.  

At the image you may see above in this help topic main window is shown in its 
simpliest state when there are no browser windows opened. In this state main 
window can implement just a few simple functions. To gain an access to more 
functions a browser window has to be opened.  

Use command New from the file menu to create a new browser window with empty 
document (no files, video streams or images opened).  

You can open an existing document (file, stream etc.) to the new browser window 
with the Open command from the file menu. 
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Browser window 

Breeze browser window includes several main user interface components:  

 

• Primary video panel  

• Assistant video panel  

• Controller panel  

• Title bar  

• Main menu  

• Toolbars  

• Status bar  

• Scroll bars 

 

 
 

Primary and assistant video panels display video data. By default primary channel is 
connected via the video output port 1 to the primary video panel, and assistant 
channel is connected via the video output port 3 to the assistant video panel. But if it 
is necessary each video panel can be connected to any of 4 available video ports. 

Title bar displays names of open input documents, files, video streams, images etc. 
for primary and assistant channels. 

Main menu provides an access to the majority of commands available in Breeze. 
Most frequently used commands are also available in the pop-up menus invoked by 
the clicking the right button of a mouse. 

Toolbars is another handy way to access Breeze commands. All commands supported 
by toolbars are also available in the main menu.  

Status bar is used to display text information about current state of a browser 
window, menus, toolbars etc. 

Each of 3 main panels of a browser window has its own scroll bars, horizontal and 
vertical ones. They allow reaching any part of a panel when size of Breeze frame 
window is small.  
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Browser window can be configured according to the concrete job. All components of 
browser window can be hidden of shown at any time, except primary video panel. 
Controller and assistant video panels, toolbars and status bar can be hidden or 
shown in all available display modes. Title bar, main menu, toolbars and status line 
are hidden or shown automatically during a switching between the normal and full 
screen display modes. 

When work in Breeze is completed and it is closing, configuration of a browser 
window is saved. When Breeze starts next time a browser window restore its 
configuration from the saved data. 
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Channels, video ports, video panels 
 

Breeze is able to process several input data streams. Those data streams are called 
channels.  

Depending on edition, Breeze can process different number of channels. See topic 
Breeze editions for details.  

User can select and control one or two input channels, called "Primary" channel and 
"Assistant" channel.  

Video data processed by Breeze are sent to the video output ports. Video output 
port, or in short "video port", is a temporary intermediate storage holding one image 
at any given moment of the time. Image from the video port can be displayed in 
video panels or used for other purposes depending on the user's choice. 

 

 

 

In the Breeze there are 4 video output ports available. Ports are numbered from 1 to 
4. Two video ports, number 1 and 2, are serving the primary channel. Another two 
ports, number 3 and 4, are serving the assistant channel. Video port 1 is used for the 
majority of video output data produced by the primary channel, and video port 2 is 
used for a more rarely used video output data. Correspondingly, video port 3 is used 
for the majority of video output data produced by the assistant channel, and video 
port 4 is used for a more rarely used video output data.  

Video output ports 1 and 3 are major video output ports. Video output ports 2 and 4 
are auxiliary video output ports. 
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By default primary channel is connected via the video output port 1 to the primary 
video panel, and assistant channel is connected via the video output port 3 to the 
assistant video panel. But if it is necessary each video panel can be connected to any 
of 4 available video ports.  

Availability of 2 video output ports for each streaming channel and 2 video panels 
able to display data from any of 4 video ports, allows reconfiguring browser window 
for a variety of jobs. 
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Operational Modes 
There are several main types of jobs implemented with video data in each streaming 
channel. Those main types of jobs are called "Operational modes" of a streaming 
channel. Table 1 enlists main operational modes currently supported by Breeze. 

Operational 
mode 

Streaming 
channel 

Data source Description 

CLOSED Closed Unavailable Video output is unavailable. Main controls 
in the browser window are disabled. 

VIEW / 
SLIDE 
SHOW 

Open Original 
stream 

User loads one image in a time per 
channel by applying "Step" / "Step back" 
commands. 

PLAY Open Original 
stream 

Single video stream or sequence of 
individual images is played automatically 
with a predefined frame rate.  
User starts and stops playing by applying 
"Start" / "Stop" / "Pause" commands. 

REPLAY Open Video cash 
buffer 

Frames stored in the video cash buffer 
during "PLAY" mode are replayed back 
and forth automatically with a predefined 
frame rate; or are stepped back and 
forth.  
User controls playing and stepping by 
applying "Replay forth" / "Replay back" / 
"Replay step" / "Replay step back" / 
"Pause replay" commands. 

EDIT Open Original 
stream 

User edit selected image in the separate 
image editor window. 

CONVERT Open Original 
stream 

Selected video or image sequence is 
converted automatically from one format 
into another. User starts, stops and 
pauses process of conversion. 

Current operational mode for each channel is shown in the left top corner of 
Controller panel, in the two text boxes titled "Mode". 
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Supported media (video, audio, image) formats and media 
devices 
 

Currently Breeze supports 100+ video, audio and image formats.  

 

Video formats.  

 

• AVI (Audio Video Interleaved). All AVI video and audio codecs, including 
MPEG 2, MPEG 4, DivX, XviD, H.264, etc. 

• MPEG 1 (Motion Pictures Expert Group)  

• MPEG 2 (Motion Pictures Expert Group)  

• MPEG 4 (Motion Pictures Expert Group)  

• VOB (DVD Video Object)  

• WMV (Windows Media Video)  

• ASF (Microsoft Advanced System Format)  

• FLV (Flash Video)  

• MOV (QuickTime Video)  

• DV (Digital Video)  

• OOV (Object Oriented Video, Part 1.H) 

• 42 YUV / YCbCr video file formats  

 

Audio formats.  

 

• MP3 - MPEG-1 Audio Layer 3  

• WMA - Windows Media Audio  

• WAV - Waveform Audio  

 

Internet streaming formats. 

 

• Video: MPEG-1, MPEG-2, MPEG-4, WMV, ASF, FLV  

• Audio: MP3, WMA 
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Media (video, audio) devices. 

 

• Webcams  

• Digital Video Camcoders (DVCAM)  

• Video cassette recorders (VCR) 

• TV Tuners  

• FM radio tuners  

• Microphones and other audio capture devices  

 

 

Image formats.  

 

• JPEG / JFIF  

o Color  

o Gray, 8 bit  

• JPEG-2000  

o Compression types: Lossless, JP2, JPC  

o RGB, 8 bit  

o RGB with transparency, 8 bit  

o Gray, 8 bit  

o Gray with alpha transparency, 8 bit  

• PNG, Portable Network Graphics  

o RGB, 8 bit  

o RGB with transparency, 8 bit  

o Color palette, 1 bit, 4 bit, 8 bit  

o Gray, 1 bit, 2 bit, 4 bit, 8 bit  

o Gray with alpha transparency, 8 bit  

o Color palette, 1 bit, 4 bit, 8 bit  

• GIF, Graphics Interchange Format (CompuServe)  

o RGB, 1 bit, 2 bit, 4 bit, 8 bit  
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• TIFF, Tagged Image File Format  

o Compression types: No compression, LZW, Packbits, ZIP, Jpeg, 
Huffman RLE, CCITT Fax 3, CCITT Fax 4  

o RGB, 8 bit  

o RGB with transparency, 8 bit  

o Color palette, 1 bit, 4 bit, 8 bit  

o Gray, 1 bit, 2 bit, 4 bit, 8 bit  

o Gray with alpha transparency, 8 bit  

• BMP, Microsoft Bitmap  

o 1 bit monochrome  

o Color palette, 4 bit, 8 bit  

o RGB, 16 bit, 24 bit  

o RGB with transparency, 32 bit  

• 42 YUV / YCbCr image file formats  

o Color conversion: ITU-T 601, ITU-T 709  

o Sub sampling: 4:4:4, 4:2:2, 4:2:0  

o Sub sampling patterns: Centered, CoSite Even, CoSite Odd  

o Data range: 0 - 255, 16 - 255, 16 - 235 - 240  

 

Video sequences presented by video formats as well as video sequences presented 
by individual images can be viewed, played, replayed back and forth, converted to 
another video or image format, saved to the file or data stream. 
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System requirements 
 

Breeze v.5.5.x works with Windows 2000 / XP / Vista.  

The minimum hardware requirements to the computer are the following:  

• CPU: Pentium III or higher  

• RAM: 128 Mbytes or more  

Current version of Breeze has been tested on x86 platforms with up to:  

• CPU: total, 4 processors or/and cores, running at the frequencies up to 
3.8 GHz  

• RAM: 16 gigabytes.  

It is IMPORTANT to remember that CPU and RAM resources required for 
processing video or graphics depend on structure and complexity of processed video 
data. Usually most important are size of picture frame, level of video compression, 
frame rate of video sequences and number of simultaneously processed video 
streams.  

For example, size of QCIF picture is 176 x 144 = 25344 pixels. Size of HDTV 
1080p video picture is 1920 x 1080 = 2073600 pixels, or about 80 time bigger than 
size of QCIF picture. Often it means that processing HDTV 1080p picture will require 
about 80 times more computations than processing of QCIF picture.  

Breeze has been tested for processing of pictures with the size up to 6000 x 3000 
pixels, or about 10 times bigger than HDTV 1080p (about 1000 times bigger than 
QCIF).  

Usually encoding and /or decoding of highly compressed video or graphics 
requires a big CPU power. Fast reversible replaying of video sequences (instant 
playback) is done usually via storing a big number of frames in RAM. It may require 
a big quantity of RAM, up to 2 gigabytes and more.  

Breeze essentially is a multiple stream processor. On the computers equipped 
with multiple processors (with single or multiple cores), Breeze may process data in 
multiple threads, utilizing all CPU resources.  

As a result, in the case of most demanding tasks, if it is required by the 
complexity of job, Breeze may utilize all CPU and RAM resources available at the 
computer.  

Multiple processor/core computer configurations are highly 
recommended when Breeze is used for playing two or more video sequences 
simultaneously. This is especially important for playing a high definition 
video, and when big magnification of video images (up to 10x), "Picture In 
Picture" or "Picture From Picture" are used. 
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Breeze Support 
 

Address:  Discovery Scientific, LLC 

P.O. Box 65510  

Lubbock, TX 79464-5510 

USA  

E-mail:   support@DiscoveryBiz.net

Web:   www.DiscoveryBiz.net

 

Click here to see "What is new in the Breeze" - learn more about new releases of 
Breeze.  

Click here to see "Frequently Asked Questions" - learn more about Breeze features. 
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3. Breeze menus 

 

File menu commands 

 

New command 

 

Use this command to create a new document in the  

Breeze browser window.  

You can open an existing document (file, stream etc.) with the 
Open or Open To command. 

 

Open command 

 

Use this command to open an existing document in a new window.  

Select the file you want to open in the File Open dialog box.  

In the new window a document (file, stream etc.) is opened to the 
primary channel.  

You can create new documents with the New command.  

You can open an existing document (file, stream etc.) to the 
channel of already created browser window with the Open To 
command. 

 

Open To command 

 

Use this command to open an existing document to the channel of already created browser 
window.  

Select the file you want to open in the File "Open To" dialog box.  

In the new window a document (file, stream etc.) is opened to the primary channel.  

You can create new documents with the New command.  

You can open an existing document (file, stream etc.) in the window with the Open command. 

 

Open URL command 

 

Use this command to open an existing document (file, stream etc.) with the given URL into the 
channel of new or already created browser window.  
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URL (Uniform Resource Locator) defines a path to a multimedia resource on the Internet, your 
computer, or your network that you want to play, stream, view or edit.  

 

Select the URL you want to open in the File "Open URL" dialog box.  

 

If a document (file, stream etc.) is opened into the newly created window, it will be open in the 
primary channel of that window.  

 

You can create new documents with the New command.  

 

You can open an existing document (file, stream etc.) from the local computer or network into 
the browser window with the Open command. 

 

Open device command 

 

Use this command to open an existing media device to the channel of new or already created 
browser window.  

 

Select the device you want to open in the File "Open device" dialog box.  

 

If device is opened into the newly created window, it will be opened in the primary channel of 
that window.  

 

You can create new documents with the New command. 

 

Close command 

 

Use this command to close all windows containing the active document.  

Breeze suggests that you save changes to your document before you close it. If you close a 
document without saving, you lose all changes made since the last time you saved it. Before 
closing an untitled document, Breeze displays the Save As 
dialog box and suggests that you name and save the 
document. 
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If only one channel, primary or assistant, is open then 

 

"Close From" command 

 

Use this command to close data stream from the channel of 
the open browser window.  

Close From command does not close browser window itself.  
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Breeze closes that open channel.  

If both channels, primary and assistant, are open, then Breeze displays dialog where you can 
select which channel has to be closed. Make a selection and click button "OK" if you want to 
close selected channels, or click button "Cancel" if you want to cancel Close From operation. 

 

Save command 

 

Use this command to save the active document to its current name and directory.  

When you save a document for the first time, Breeze displays the Save As dialog box so you 
can name your document.  

If you want to change the name and directory of an existing document before you save it, 
choose the Save As command. 

 

Save As command 

 

Use this command to save and name the active document.  

Breeze displays the Save As dialog box so you can name your document.  

To save a document with its existing name and directory, use the Save command. 

 

Files of Type 

 

Select types of files which can be open to the channels in the "View" mode. 

 

Sort By 

 

Select the sorting order for the files which can be open to the channels in the "View" mode. 

 

Print command 

 

Use this command to print a document.  

This command presents a Print dialog box, where you may specify the range of pages to be 
printed, the number of copies, the destination printer, and other printer setup options. 

 

Print Preview command 

 

Use this command to display the active document as it would appear when printed.  

When you choose this command, the main window will be replaced with a print preview window 
in which one or two pages will be displayed in their printed format.  
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The print preview toolbar offers you options to view either one or two pages at a time; move 
back and forth through the document; zoom in and out of pages; and initiate a print job. 

 

Print Setup command 

 

Use this command to select a printer and a printer connection.  

This command presents a Print Setup dialog box, where you specify the printer and its 
connection. 

 

Send command 

 

Use this command to send the active document through e-mail.  

This command presents a mail window with the active document attached to it. You may then 
fill out the To field, Subject field, and so on, and add text to the body of the message. When 
you are finished, you can click the Send button to send the message. 

 

Exit command 

 

Use this command to end your Breeze session.  

You can also use the Close command on the application Control menu. Breeze prompts you to 
save documents with unsaved changes. 
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Edit menu commands 
 

Undo/Can't Undo command 

Use this command to reverse the last editing action, if possible.  

The name of the command changes, depending on what the last 
action was. The Undo command changes to Can't Undo on the 
menu if you cannot reverse your last action. 

 

Cut command 

Use this command to remove the currently selected data from the document and put it on the 
clipboard.  

This command is unavailable if there is no data currently selected.  

Cutting data to the clipboard replaces the contents previously stored there. 

 

Copy command 

Use this command to copy selected data onto the clipboard.  

This command is unavailable if there is no data currently selected.  

Copying data to the clipboard replaces the contents previously stored there. 

 

Paste command 

Use this command to insert a copy of the clipboard contents at the insertion point.  

This command is unavailable if the clipboard is empty. 
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View menu commands 

 

 

Primary Video Panel Maximized 

Use this command to maximize or minimize primary video panel.  

         

This command hides or shows assistant and controller panels.  

A checkmark appears next to the menu item when the primary video panel is maximized.  

Assistant Video Panel 

Use this command to show or hide assistant video panel.  

         

A checkmark appears next to the menu item when the assistant video panel is shown.  
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Controller 

Use this command to show or hide controller panel. 

         

 

A checkmark appears next to the menu item when the controller video panel is shown.  

These commands also available in the pop up menu of a Browser window.  

First 3 buttons of the "View" toolbar corresponds to these commands too. 

 

 

 

"Full Screen" commands 

Use this command to return a browser window from the "Full screen" state 
to the "Normal screen" state. 

In the "Normal screen" state title bar, main menu, toolbars, and status 
bar are visible. If assistant video panel and controller panel were visible 
before browser window was switched to the "Full screen" state, then these 
panels becomes visible again after returning a browser to the "Normal 
screen" state.  

A checkmark appears next to the menu item when browser window is in the "Normal screen" 
state.  

 

Full screen with controls 

Use this command to switch a browser window to the "Full screen with controls" state.  

         

 

This full screen state can be used for viewing individual images, for slide show, and for playing 
video.  

In the "Full screen with controls" state a browser windon uses almost all available screen area 
for showing images, on the one hand, and, at the same time, provides a direct access to the 
most important commands via the toolbars and, if it is necessary, via a controller panel, on the 
other hand.  

In the "Full screen with controls" state title bar, main menu, and status bar are hidden.  
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State of assistant video panel, controller panel and toolbars is same as it was in the "Normal 
screen" state. It allows cofiguring browser window for different types of slide shows or video 
playing, with one or two sets of slides in the primary and / or assistant video panels.  

A checkmark appears next to the menu item when browser window is in the "Full screen with 
controls" state.  

Full screen 

Use this command to switch a browser window to the "Full screen" state. 

         

 

This full screen state can be used for viewing individual images, for slide show, and for playing 
video.  

In the "Full screen" state a browser windon uses all available screen area for showing images.  

In the "Full screen" state title bar, main menu, toolbars and status bar are hidden.  

State of assistant video panel, controller panel and toolbars is same as it was in the "Normal 
screen" state. It allows cofiguring browser window for different types of slide shows or video 
playing, with one or two sets of slides in the primary and / or assistant video panels.  

"Full screen" state is initiated and controlled by the user via the main menu, the pop up menu 
of a browser window or via the "View" toolbar.  

A checkmark appears next to the menu item when browser window is in the "Full screen" state.  

Full screen auto 

Use this command to switch a browser window to the "Full screen auto" state.  

         

 

This full screen state can be used for viewing individual images, for slide show, and for playing 
video.  

In the "Full screen auto" state a browser windon uses all available screen area for showing 
images.  

In the "Full screen auto" state title bar, main menu, toolbars and status bar are hidden.  

State of assistant video panel, controller panel and toolbars is same as it was in the "Normal 
screen" state. It allows cofiguring browser window for different types of slide shows or video 
playing, with one or two sets of slides in the primary and / or assistant video panels.  

"Full screen auto" state is initiated and controlled by the user via the main menu, the pop up 
menu of a browser window or via the "View" toolbar.  
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During playing video in the "Full screen auto" state a browser window automatically switching 
to the "Full screen" state if for several seconds computer keyboard and mouse are inactive. 
Browser window is switching automatically back to the "Normal screen" if keyboard or mouse 
becomes active again and send commands to the computer.  

A checkmark appears next to the menu item when browser window is in the "Full screen auto" 
state.  

"Normal", "Full screen with controls", "Full screen", "Full screen auto" commands also availabe 
in the pop up menu of a Browser window.  

Last 4 buttons of the "View" toolbar corresponds to these commands too. 
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"Picture in Picture" commands (View menu)   

 

PIP: Primary Video Panel  

 

Use this command to enable/disable "Picture In Picture" in the primary video panel.  

A checkmark appears next to the menu item when PIP for the primary panel is enabled.  

 

PIP: Assistant Video Panel  

 

Use this command to enable/disable "Picture In Picture" in the assistant video panel.  

A checkmark appears next to the menu item when PIP for the assistant panel is enabled.  

 

PIP (Picture In Picture) Options...  

 

Use this command to Open "Picture In Picture" options dialog.  

 

Remarks  

 

Source video port for the inserted picture, position and size of a PIP rectangle can be specified 
in the "Picture In Picture" options dialog. The fastest way to access that options dialog is to use 
the "PIP (Picture In Picture) Options..." command in the "View" menu. It can also be accessed 
via the "Options..." command in the "Tools" menu.  

"Picture and Picture" source image can be taken from any of 4 available video ports and 
inserted in any video panel.  

If video port is receiving data from the stopped or paused channel then inserted picture is 
static (presents no motion). If video port is receiving data from the playing channel then 
inserted picture is dynamic (presents video motion).  

Turning On and Off PIP operations can be done in the described here options dialog "Picture In 
Picture". But faster way to do that is to use buttons "Enable/Disable 'Picture In Picture" buttons 
in the "View" toolbar or in the "View" menu. 
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Zoom commands (View menu) 

"Zoom plus", "Zoom minus" commands 

Use these commands to zoom in and zoom out images in the primary and assistant video 
panels.  

Unzoomed image corresponds to the zoom 100% or 1x.  

Maximum size of a zoomed image is 1000% or 10x.  

Minimum size of a zoomed image is 10% or 0.1x.  

These two commands are also available in the "Zoom" toolbar as buttons (+) and (-).  

Fixed "Zoom 1000%" to "Zoom 10%" commands 

Use these commands to zoom in and zoom out images in the primary and assistant video 
panels.  

The full set of fixed zoom levels are the following:  

1000%, 500%, 200%, 175%, 150%, 125%, 100%, 50%, 25%, 10%.  

Unzoomed image corresponds to the zoom 100% or 1x.  

Maximum size of a zoomed image is 1000% or 10x.  

Minimum size of a zoomed image is 10% or 0.1x. 

 

Fit view command 

Use this command to zoom images in the primary and assistant panels in such a way where 
each image fits entirely within the borders of the panel view.  

Sizes of primary and assistant panels can be changed by repositioning a horizontal bar 
separating these two panels. In the "Fit view" zoom mode changing a size of panel leads also to 
the changing sizes of images displayed in the panels.  

 

Fit width command 

Use this command to zoom images in the primary and assistant panels in such a way where 
each image fits to the width of a panel view.  

 

Fit height command  

Use this command to zoom images in the primary and assistant panels in such a way where 
each image fits to the height of a panel view.  

 

Fill view command  

Use this command to zoom images in the primary and assistant panels in such a way where 
each image fills an entire panel view.  

Custom zoom command  

Use this command to set custom zoom for images in the primary and assistant panels.  

A checkmark appears next to the menu item when any of above commands are selected.  

"Zoom 100%", "Fit view", "Fit width", "Fit height", "Fill view" commands are also available in 
the "Zoom" toolbar. 
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Toolbar commands (View menu) 

 

Toolbar "Standard" command 

Use this command to display and hide the "Standard" toolbar, which includes buttons for some 
of the most common commands in Breeze, including:  

"New", "Open", "Open To", "Save", "Cut", "Copy", "Paste", "Print", "About Breeze", "Help".  

A checkmark appears next to the menu item when the "Standard" toolbar is displayed.  

 

Toolbar "Go" command 

Use this command to display and hide the "Go" toolbar, which includes buttons for "Step" and 
"Play" commands, including:  

"Step", "Step back", "Start", "Stop", "Pause play", "Replay step", "Replay step back", "Replay", 
"Replay back", "Replay stop", "Set start", "Set end".  

A checkmark appears next to the menu item when the "Standard" toolbar is displayed.  

 

Toolbar "Channel" command 

Use this command to display and hide the "Channel" toolbar, which includes buttons for the 
channel related commands, including:  

"Enable channel 1", "Enable channel 2", "Switch enable channels", "Reverse replay direction for 
channel 1", "Reverse replay direction for channel 2", "Reverse both channels", "Synchronize 
frame output for channels", "Enable save from channel 1", "Enable save from channel 2", 
"Reverse enable save".  

A checkmark appears next to the menu item when the "Channel" toolbar is displayed.  

 

Toolbar "View" command 

Use this command to display and hide the "View" toolbar, which includes buttons for the view 
commands, including:  

"Primary panel maximized", "Show / hide assistant video panel", "Show / hide controller video 
panel", "Normal view", "Full screen with controls", "Full screen", "Full screen auto".  

A checkmark appears next to the menu item when the "View" toolbar is displayed.  

 

Toolbar "Zoom" command 

Use this command to display and hide the "Zoom" toolbar, which includes buttons for the view 
commands, including:  

"Zoom 100%", "Zoom to fit view", "Zoom to fit width", "Zoom to fit height", "Zoom to fill view", 
"Zoom out (-)", "Zoom in (+)".  

A checkmark appears next to the menu item when the "View" toolbar is displayed.  

See Toolbar for help on using the toolbar. 
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Status Bar command (View menu) 

 

Use this command to display and hide the status bar, which describes the action to be executed 
by the selected menu item or pressed toolbar button, and keyboard latch state.  

A checkmark appears next to the menu item when the status bar is displayed.  

See Status Bar for help on using the status bar. 

 

 

Image menu commands 
 

Convert command 

Use this command to convert image or video 
sequence from one format to another. 

 

Filter command 

Use this command to filter image or video sequence. 

 

Capture command 

Use this command to caputre video sequence. 

 

PSNR command 

Use this command to calculate PSNR - Pick Sigrnal to Noise Ratio.  

Value of PSNR is calculated for the two images in the video ports 1 and 3. 

 

Properties command 

Use this command to display a dialog with description of image properties. 

 

Refresh Image command 

Use this command to refresh images displayed in the video panels. 

 

 



Breeze User Guide                                                                                                                            Breeze menus 
 

Channel menu commands 
The Channel menu offers the following commands. 

 

Properties 

Open options dialog "Channels". 

 

"Play primary channel" command 

Use this command to enable or disable playing the primary 
channel (channel No.1).  

If playing is enabled in the primary channel, then commands 
Start , Replay forth, Replay back, Replay step, Replay step 
back start playing or stepping the primary channel. If playing 
is disabled then the primary channel stays inactive when 
these commands are applied.  

A checkmark appears next to the menu item when this 
command is selected.  

 

"Play assistant channel" command 

Use this command to enable or disable playing the assistant channel (channel No.2).  

If playing is enabled in the assistant channel, then commands Start , Replay forth , Replay 
back, Replay step , Replay step back start playing or stepping the assistant channel. If playing 
is disabled then the assistant channel stays inactive when these commands are applied.  

A checkmark appears next to the menu item when this command is selected.  

 

"Switch 'Play' for both channels" command 

Use this command to switch "Enable playing" state for both channels, No.1 and No.2.  

 

"Reverse primary channel" command 

Use this command to reverse replay direction for the primary channel (channel No.1).  

A checkmark appears next to the menu item when this command is selected.  

 

"Reverse assistant channel" command 

Use this command to reverse replay direction for the assistant channel (channel No.2).  

A checkmark appears next to the menu item when this command is selected.  

 

"Switch 'Reverse direction' for both channels" command 

Use this command to switch "Reverse direction" state for both channels, No.1 and No.2.  
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"Synchronize channels" command 

Use this command to synchronize frame output for primary and assistant channels (channels 
No.1 and No.2).  

A checkmark appears next to the menu item when this command is selected.  

 

"Save primary channel" command 

Use this command to save video from the primary channel (channel No.1).  

A checkmark appears next to the menu item when this command is selected.  

 

"Save assistant channel" command 

Use this command to save video from the assistant channel (channel No.2).  

A checkmark appears next to the menu item when this command is selected.  

 

"Switch "Save" for both channels" command 

Use this command to switch "Enable save" state for both channels (channels No.1 and No.2).  

A checkmark appears next to the menu item when this command is selected. 

 

"Capture primary video panel" command 

Use this command to capture a picture from the primary video panel to the file.  

Video panel is captured "As Is". Any video port can be selected into the video panel (see 
"Controller panel" topic). If filtering or "Picture In Picture" operations are applied to the image 
currently displayed in the video panel then captured image will reflect all those changes.  

A checkmark appears next to the menu item when this command is selected. 

 

"Capture assistant video panel" command 

Use this command to capture a picture from the assistant video panel to the file.  

Video panel is captured "As Is". Any video port can be selected into the video panel (see 
"Controller panel" topic). If filtering or "Picture In Picture" operations are applied to the image 
currently displayed in the video panel then captured image will reflect all those changes.  

A checkmark appears next to the menu item when this command is selected. 

 

TV Tuner: primary channel" command  

Open options dialog for the TV tuner of the primary channel.  

 

"TV Tuner: assistant channel" command  

Open options dialog for the TV tuner of the assistant channel. 
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The Go menu offers the following commands. 

 

"Start" command  

 

Use this command to start playing a video sequence / 
sequences in one or two channels.  

If channel is open, and playing is enabled then command 
"Start" initiate playing a video sequence.  

If playing started successfully then item "Start" in the "Go" 
menu and in the pop up menu of a browser window 
becomes disabled (gray color). Button "Start" in the "Go" 
toolbar also become disabled.  

At the same time items "Pause / Replay" and "Stop" in the 
"Go" menu and in the pop up menu of a browser window 
become enabled. Buttons "Pause / Replay" and "Stop" in the "Go" toolbar also becomes 
enabled.  

If command "Start" has been successful the browser window changes its working mode from 
the "View" to "Play".  

In the "Play" mode browser windows manages video sequence consisting of separate files same 
way as the single video file / stream consisting of multiple frames.  

 

"Pause / Replay" command  

 

Use this command to pause direct playing of video sequence / sequences in one or two 
channels.  

If playing was paused successfully then "Replay" mode is initiated. In that mode frames 
collected in the replay cash buffer can be replayed again, back and forth.  

When playing is paused there are 3 main choices:  

• Apply command "Start" to continue playing  

• Apply command "Stop" to stop playing  

• Apply one of "Replay" mode commands:  

o "Replay step"  

o "Replay step back"  

o "Replay"  

o "Replay back".  

 

"Stop" command 

Use this command to stop playing a video sequence / sequences in one or two channels and to 
return browser window from the "Play" mode to the "View" mode.  
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If playing was stopped successfully then all items of "Go" menu and in the pop up menu of a 
browser window become disables, except item "Start". All buttons in the "Go" toolbar also 
become disabled except button "Start".  

 

"Step" command  

 

Use this command to step forth within sequence of separate files placed inside one folder in the 
local computer, or on the intra or internet. During executing "Step" command browser window 
stays in the "View" mode.  

If both channels, primary and assistant, are open then "Step" command advances video 
sequences in both channels. If in one channel the very last file has been reached already, 
before applying "Step" command, then only one channel is advanced by one step forth.  

The order in which separate files or streams are loaded to the channels by the broser window 
corresponds to the sorting rules defined by the operating system for the folder where a 
sequence those separate files / streams is placed.  

Command "Step" manages video files consisting of many frames similar to the files contaniing 
just one image. If file / stream is loaded to the channel by the "Step" command successfully, 
then the very first frame of the video sequence or single image of the picture file is displayed in 
the video panel.  

 

"Step back" command  

 

Use this command to step back within sequence of separate files placed inside one folder in the 
local computer, or on the intra or internet. During executing "Step back" command browser 
window stays in the "View" mode.  

If both channels, primary and assistant, are open then "Step back" command advances video 
sequences in both channels. If in one channel the very first file has been reached already, 
before applying "Step back" command, then only one channel is advanced by one step back.  

The order in which separate files or streams are loaded to the channels by the broser window 
corresponds to the sorting rules defined by the operating system for the folder where a 
sequence of those separate files / streams is placed.  

Command "Step back" manages video files consisting of many frames same way as the files 
contaniing just one image. If file / stream is loaded to the channel by the "Step back" 
command successfully, then the very first frame of the video sequence or single image of the 
picture file is displayed in the video panel.  

 

"Replay step" command  

 

Use this command to step one frame forth within the replay cash buffer.  

If both channels, primary and assistant, are open and playing for channels is enabled then 
"Replay step" command advances video sequences in both channels.  
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"Replay step back" command  

 

Use this command to step one frame back within the replay cash buffer.  

If both channels, primary and assistant, are open and playing for channels is enabled then 
"Replay step back" command advances video sequences in both channels.  

 

"Replay forth" command  

 

Use this command to replay forth frames within the replay cash buffer.  

If both channels, primary and assistant, are open and playing for channels is enabled then 
"Replay forth" command replays sequences in both channels.  

 

"Replay back" command  

 

Use this command to replay back frames within the replay cash buffer.  

If both channels, primary and assistant, are open and playing for channels is enabled then 
"Replay back" command replays sequences in both channels.  

 

"Set start" command  

 

Use this command to set current frame to the start of the replay cash buffer .  

If both channels, primary and assistant, are open and playing for channels is enabled then "Set 
start" command advances sequences in both channels.  

 

"Set end" command  

 

Use this command to set current frame to the very end of the replay cash buffer.  

If both channels, primary and assistant, are open and playing for channels is enabled then "Set 
start" command advances sequences in both channels.  

 

"Pause replay" command  

 

Use this command to pause replaying from the replay cash buffer.  

If both channels, primary and assistant, are open and playing for channels is enabled then "Set 
start" command stops replaying in both channels. 
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Tools menu commands 
The Tools menu offers the following commands. 

 

"Set reference frames..." command  

Use this command to open the "Reference frames" dialog where you 
can set start and stop reference frames used for playing a fragment 
of video sequence.  

If channel is open, and playing for channels is enabled, and 
command "Start" is applied then video sequence begin to play. All frames placed within video 
sequence before start reference frame are skipped as fast as possible. Skipped frames are not 
displayed in the browser window.  

Beginning from the start reference frame video sequence is played with normal speed and all 
frames are displayed in the browser window, until the stop reference frame is reached.  

Playing is stopped when stop reference frame is reached.  

Start and stop frames can also be set in the "Read stream" dialog. This dialog can be accessed 
via command "Options...".  

 

"Options..." command 

Use this command to open "Options" dialogs .  

This command is also available in the pop up menu of the browser window. 

 

Media Device Options 

Open "Media Device Options" sub menu 

 

Use this command to open a submenu "Media Device Options" .  

 

Options dialogs for media devices produces by different vendors may be different. 
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Window menu commands 
 

The Window menu offers the following commands, which enable you to 
arrange multiple views of multiple documents in the application window. 

 

New command 

Use this command to open a new window with the same contents as the 
active window.  

You can open multiple document windows to display different parts or views of a document at 
the same time. If you change the contents in one window, all other windows containing the 
same document reflect those changes. When you open a new window, it becomes the active 
window and is displayed on top of all other open windows. 

 

Cascade command 

Use this command to arrange multiple opened windows in an overlapped fashion. 

 

Tile Horizontally command 

Use this command to vertically arrange multiple opened windows in a non overlapped fashion. 

 

Tile Vertically command 

Use this command to arrange multiple opened windows side by side. 

 

Window Arrange Icons command 

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.  

If there is an open document window at the bottom of the main window, then some or all of 
the icons may not be visible because they will be underneath this document window. 

 

1, 2, ... command 

Breeze displays a list of currently open document windows at the bottom of the Window menu. 
A checkmark appears in front of the document name of the active window. Choose a document 
from this list to make its window active. 
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Help menu commands 
 

The Help menu offers the following commands, which provide you 
assistance with this application. 

 

Index command 

Use this command to display the opening screen of help.  

From the opening screen, you can jump to step-by-step instructions for using Breeze and 
various types of reference information.  

Once you open help, you can click the Contents button whenever you want to return to the 
opening screen. 

 

About command 

 

Use this command to display the copyright 
notice and version number of your copy of 
Breeze.  

"About" dialog includes button "Visit" and 
text link. Click any of them to visit support 
web site of Breeze www.DiscoveryBiz.net.  

Breeze, Standard Edition and Professional 
Edition software packages include 30 days 
trial evaluation period.  

Evaluation period starts immediately after 
installing a software. During this period 
functionality of software is same as in the 
activated software. To continue using software after evaluation period expires, software has to 
be activated with a License key. License key for downloaded software can be purchased on-line 
at www.DiscoveryBiz.net.  

Activation license key is issued immediately after purchasing a product.  

Subscription access key for packages with 12 months subscription for free download upgrades, 
is issued immediately after purchasing a product.  

After license key is obtained, Breeze can be activated. During evaluation period "About" dialog 
box shows button "Activate". Click this button to open the "Breeze: product acitivation dialog. 
Enter license key in the activation dialog and then press button "Submit".  

Before activation "About" dialog displays text information showing how many days are left for 
the trial evaluation. After successful activation "About" dialog displays activation license key. 
Button "Activate" is not shown in the "About" dialog box after activation. 

 

 



Breeze User Guide                                                                                                                            Breeze menus 
 

Pop up menu of a browser window 

 
 

The Pop up menu of a browser window offers the following commands. 

Start Start playing.  

Pause / Replay Pause play / Set replay mode. 

Stop  Stop playing.  

Copy Copies data from the document to the clipboard.  

Paste Pastes data from the clipboard into the document. 

Open To Opens an existing document to the channel.  

Save As Saves an opened document to a specified file name.  

Print Prints a document.  

Primary Video Panel Maximized Maximize or minimize primary video panel.  

Assistant Video Panel Show or hide assistant video panel.  

Controller Show or hide controller panel.  

Normal Normal screen view.  

Full screen with controls Full screen view with controls/ slides and video.  

Full screen Full screen view / slides and video.  

Full screen auto Full screen view auto hide / video.  

Options... Open "Options" dialogs 
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4. Toolbars 
 

Toolbars are displayed across the top of the application window, below the menu bar. They 
provide quick mouse access to many tools used in Breeze.  

To hide or display the toolbar, click Toolbar from the View menu, and then select toolbar you 
want to show or hide.  

Another way to show or hide toolbars is to place mouse cursor over the toolbar panel and to 
click right button of a mouse. A drop down list of toolbars names will appear over toolbar panel. 
Click the toolbar you want to show of hide.  

When Breeze main window is minimized some toolbars will display only part of all available 
buttons. In that case on the right side of toolbar a chevron ">>" icon appears, indicating that 
there are more toolbar buttons available than it is displayed currently. To access hidden 
buttons click chevron icon">>". A drop down list of hidden buttons together with definitions of 
commands will appear. Click the button corresponding to the command you need.  

Currently Breeze supports the following toolbars:  

 

Standard Most frequently used commands  

Go Main commands used by the browser window in the "Play" mode  

Channel Commands controlling state of channels  

View Commands controlling configuration of video panels in the browser window  

Zoom Commands controlling zooming of images displayed in the browser window 

 

"Standard" toolbar 

 

 

The Standard toolbar offers the following commands:  

 

New  Creates a new document.  

Open  Opens an existing document.  

Open  To Opens an existing document to the channel.  

Save Saves an opened document using the same file name.  

Cut  Deletes data from the document and moves it to the clipboard.  

Copy  Copies data from the document to the clipboard.  

Paste  Pastes data from the clipboard into the document.  

Print  Prints a document.  

Help  Topics Offers you an index to topics on which you can get help.  

About  Displays the version number of this application. 
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"Go" toolbar 

 

The Go toolbar offers the following commands: 

 

Stop  Stop playing  

Step back  Step back  

Start  Start playing  

Step  Step forth.  

Pause / Replay  Pause play / Set replay mode  

Set start  Set current frame to the start of the buffer  

Replay back  Replay back  

Replay step back  Step back in replay mode  

Pause replay Pause replaying  

Replay step forth  Step forth in replay mode  

Replay forth  Start forth in replay mode  

Set end  Set current frame to the very end of the buffer  
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"Channel" toolbar 
 

 

The Channel toolbar offers the following commands: 

 

Play primary channel   Enable/Disable playing primary channel.  

Play assistant channel  Enable/Disable playing assistant channel .  

Switch "Play" for both channels  Switch "Enable playing" state for both channels.  

Reverse primary channel  Reverse replay direction for primary channel.  

Reverse assistant channel  Reverse replay direction for assistant channel .  

Reverse both channels  Reverse replay direction for both channels.  

Synchronize channels  Synchronize frame output for primary and assistant 
channels.  

Save primary channel   Save video from the primary channel.  

Save assistant channel  Save video from the assistant channel.  

Switch "Save" for both channels   Switch "Enable saving" state for both channels. 

Capture primary video panel Capture a picture from the primary video panel to the 
file. 

Capture assistant video panel Capture a picture from the assistant video panel to the 
file. 
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"View" toolbar 
 

 

 

The View toolbar offers the following commands:  

 

Primary Video Panel Maximized Maximize or minimize primary video panel.  

Assistant Video Panel Show or hide assistant video panel.  

Controller  Show or hide controller panel.  

Normal  Normal screen view.  

Full screen with controls  Full screen view with controls/slides and video. 

Full screen  Full screen view/slides and video.  

Full screen auto  Full screen view auto hide / video.  

PIP: Primary Video Panel  Enable/Disable "Picture In Picture" in the primary video 
panel.  

PIP: Assistant Video Panel  Enable/Disable "Picture In Picture" in the assistant video 
panel. 
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"Zoom" toolbar 
 

 

 

The Zoom toolbar offers the following commands:  

 

Zoom 100%  Zoom to 100%.  

Fit view  Zoom to fit image into view.  

Fit width  Zoom to fit width.  

Fit height  Zoom to fit height.  

Fill view  Zoom to fill entire view with image.  

Zoom plus  Zoom in view (+).  

Zoom minus  Zoom out view (-). 
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Status Bar 
 

The status bar is displayed at the bottom of the Breeze window. To display or hide the status 
bar, use the Status Bar command in the View menu.  

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus. This area similarly shows messages that describe the actions of 
toolbar buttons as you press them, before releasing them. If after viewing the description of 
the toolbar button command you wish not to execute the command, then release the mouse 
button while the pointer is off the toolbar button.  

The right areas of the status bar indicate which of the following keys are latched down:  

 

Indicator Description  

CAP The Caps Lock key is latched down.  

NUM The Num Lock key is latched down.  

SCRL The Scroll Lock key is latched down. 

 

42 

Copyright ©2008 · Discovery Scientific, LLC  
 



Toolbars                                                                                                                                     Breeze User Guide 

 

43 

Copyright ©2008 · Discovery Scientific, LLC  

Breeze shortcut keys 
Breeze shortcut keys provides a fast access to the frequently used commands directly from the 
computer keyboard.  

 

"View" mode of a browser window  

 

Page Down Step forth within the sequence(s) of separate files placed in the 
same folder 

Page Up Step back within the sequence(s) of separate files placed in the 
same folder. 

Ctrl-Enter Start playing a video sequence(s) in one or two channels. 

 

"Play" and "Replay" modes of a browser window  

 

Ctrl-Backspace Stop playing a video sequence(s) and to return from the "Play" to 
the "View" mode. 

Enter Pause direct playing of video sequence(s) and initiate "Replay" 
mode (replay from the replay cash buffer). 

Down arrow Replay forth frames within the replay cash buffer. 

Up arrow Replay back frames within the replay cash buffer. 

Right arrow Replay step forth by one frame within the replay cash buffer. 

Left arrow Replay step back by one frame within the replay cash buffer. 

Home Set to the start of the replay cash buffer. 

End Set to the end of the replay cash buffer. 

 

"Full screen" and "Zoom" commands of a browser window  

 

Esc Normal screen 

F5 Full screen 

Alt-Enter Full screen auto 

+ (Plus key) Zoom plus (Zoom in) 

- (Minus key) Zoom out (Zoom out) 
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5. "Options" dialogs 
"Options" dialog boxes provides you the means to configure and monitor a number important 
features of the Breeze.  

The majority of "Options" dialogs are available via the main menu item "Options...". That 
item is also available in the pop up menu of a browser window.  

Several options dialogs are accessed via the file manager dialogs. 

Currently Breeze supports the following "Options" dialogs: 

 

General This dialog displays general information about Breeze, including its 
edition and version. 

Channels This dialog display information about channels. 

Read stream This dialog allows you to enable / disable reading of input streams and 
set their parameters. 

Save sequence This dialog allows you to enable/disable "Save" operations for 
processed streams and set parameters of "Save" operations. 

Capture image This dialog allows you to enable / disable "Save captured image" 
operation for processed streams and set parameters of "Save captured 
image" operations. 

Video This dialog allows you to specify parameters of Breeze during playing a 
video. 

Video panel This dialog allows you to set image drawing parameters of video 
panels. 

Picture In Picture This dialog allows you to enable / disable "Picture In Picture" operations 
for each video panel and set parameters of "Picture In Picture" 
operations. 

Files of Type This dialog allows you to select types of files which can be open to the 
channels in the "View" mode. 

Set "Save" paths This dialog allows you to select a path, file or folder, where video 
sequence will be saved. 

File formats: YUV This dialog allows you to specify parameters of YUV format file / 
stream. 

File formats: JPEG This dialog allows you to specify parameters of JPEG file / stream 
format. 

File formats: PNG This dialog allows you to specify parameters of PNG file / stream 
format. 

Reference frames This dialog allows you to set start and stop reference frames used for 
playing a fragment of video sequence. 
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"General" options dialog box 
 

This dialog displays general information about 
Breeze, including its edition and version. 

 

 

 

 

 

 

 

 

 

 
 
 

"Channels" options dialog box 
This dialog display information about 
channels.  

Upper info panel displays information about 
primary channel. Bottom info pane displays 
information about assistant channel. 
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"Read stream" options dialog box 
 

 
 

This dialog allows you to enable / disable reading of input streams and set their parameters.  

There are two main panels in this dialog, upper panel and lower panel. Upper panel is 
associated with the primary channel, and lower panel is associated with the assistant channel. 
At the very bottom of the dialog there are also additional controls associated with both 
channels.  

The following options are available in this dialog:  

"Enable reading" check box  

Enables / disables reading of both channel independently on whether individual channels are 
enabled or not.  

"Enable channel" check box  

Enable / disable reading for the individual channel, primary or assistant.  
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"File format" text box  

This field shows a format of the stream open to the channel.  

"Single image in file" check box  

Files / streams of some types can be processed by two ways:  

• As a file with just single image in file, or  

• As a video sequences consisting of many images (frames) saved in one file.  

One popular example is YUV files.  

"Single image in file" check box allows to specify how to process that sort files / streams.  

This check box is enabled only for the file formats wich can be used both ways, as video and as 
single image file.  

Breeze disables this check box for file / stream formats which can be processed only as a video 
sequence or as a file with just single image in it. In that case check box shows the type of file / 
stream open to the channel.  

Configuration file  

If this field is enabled it allows to select configuration file specifying parameters of the channel 
and the stream open to the channel.  

"Start frame" and "Stop frame" edit boxes  

This dialog allows you to set start and stop reference frames used for playing a fragment of 
video sequence.  

If channel is open, and playing for channels is enabled, and command "Start" is applied then 
video sequence begin to play. All frames placed within video sequence before start reference 
frame are skipped as fast as possible. Skipped frames are not displayed in the browser window.  

Beginning from the start reference frame video sequence is played with normal speed and all 
frames are displayed in the browser window, until the stop reference frame is reached.  

Playing is stopped when stop reference frame is reached.  

To play very long video sequence without stops, set stop frame to some very big number. 
Default value set by Breeze is 1,000,000,000. That value allows to play video at the frame rate 
30 frames per second during 1 year and 3 months without stops.  

Start and stop frames can also be set in the "Reference frames" dialog available via the item 
Set reference frames... of the "Tools" menu.  

"Frame cash size" edit box  

Use this edit box to set number of frames in the frame cash buffers for primary and assistant 
channels.  

Each channel has its independent frame cash buffer. Both frame cash buffers have the same 
number of frames.  

During playing video sequences frames are collected in the frame cash buffers until buffers 
become filled completely. After that, the new coming frames replace the very last ones. 
Collected frames can later be replayed from the frame cash buffers. 
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"Save sequence" options dialog box 
 

 

 

This dialog allows you to enable / disable "Save" operations for processed streams and set 
parameters of "Save" operations.  

There are two panels in this dialog, upper panel and lower panel. Upper panel is associated 
with the primary channel, and lower panel is associated with the assistant channel.  

The following options are available in this dialog: 

 

 

"Enable 'Save" operation" check box  

Enables / disables "Save" operations for both channels, independently on whether those 
operations for individual channels are enabled or disabled (grayed).  

 

"Enable 'Save' operation for primary / assistant channel" check box  

Enable / disable "Save" operations for the individual channel, primary or assistant.  
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"Save image file format" combo box  

Click the arrow on the right side of this combo box to open a list of all available file formats 
which can be used to save video sequence from the active channel.  

There are two sub groups of file formats included in this list:  

• File formats which do not require additional specification, like Microsoft Bitmap (*.bmp)  
• File formats which may require additional specification, like JPEG, PNG, YUV etc.  

If you selected file format of the first type then button "Advanced...", placed to the right of the 
"Save image file format" combo box, is disabled (grayed). Disabling that button means that 
you do not need enter any additional information.  

If you selected file format of the second type then button "Advanced...", placed to the right of 
the "Save image file format" combo box, is enabled. If that button is enabled, it means that 
you may need to enter additional information about selected file format.  

For example, JPEG and PNG file format may require setting a level of compression, and internal 
image sub format; YUV file format may require specifying how YUV images will be saved, in 
one file with multiple images, or in multiple files with single image in each file, etc.  

 

"Paths and files" group box  

In this group box you have to specify a full path to the file / files where video data from the 
channel will be saved.  

 

"Save all images in one file" and "Save each image as separate file" radio buttons  

Select single of multiple file format for the "Save" operation.  

If file format selected in the combo box "Save image file format" allows to save images from 
the channel in two ways, as:  

• All images are saved in one file,  
• Each image is saved as a separate file,  

then both radio buttons are enabled. Click a required radio button to select the variat you need.  

If file format selected in the combo box "Save image file format" allows to save images from 
the channel in just one way, then Breeze disable (grays) one of two radio buttons, leaving 
enabled the one which corresponds to the selected file format.  

 

 

 

 

"Options..."  

Click this button to open the dialog where you can specify a full path to the file / files where 
video data from the channel will be saved. This data has to specified at least ones. Otherwise 
"Save" operations will be disabled.  

 

"Frames to save" group box  
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In this group box you may set a range of frames which have to be saved from the channel. 

 

 

"All frames" check box  

Check this box to save all frames from the channel.  

If this box is checked then all frames will be saved, and values of "Start frame" and "End 
frame" are ignored.  

"Start frame" and "End frame" edit boxes  

In these edit boxes you can set the range of frames which have to be saved.  

Values of "Start frame" and "End frame" are taken in account only if check box "All frames" is 
unchecked, otherwise values of start and end frames are ignored.  

Frames are saved to the file / files if the following conditions are met:  

• "Save" operation is enabled for the channel,  
• Video sequence is playing,  
• Check box "All frames" is unchecked,  
• Order number of the currently displayed frame is between values of "Start frame" and 

"End frame".  

 

"Picture In Picture" group box 

 

In this group box you may set "Picture In Picture" parameters for "Save sequence" operations. 

 

"Enable 'Save' as PIP" check box 

 

Check this box to enable saving frames of video sequence as a "Picture In Picture".  

If this box is checked then frames of video sequence may (or may not) be saved as a PIP. 
Frames are saved as PIP if general "Picture In Picture" operations are enabled for the channel, 
and may not be save as PIP if general "Picture In Picture" operations are disabled. Enabling / 
disabling general "Picture In Picture" operations can be done via the "View" menu, by clicking 
buttons in the "View" toolbar, or by clicking check boxes in the "Picture In Picture" options 
dialog. Table below summarizes 4 possible combinations of states for the "Enable 'Save' as PIP" 
check box and for the "Enable/Disable general "Picture In Picture" operations" check box 
(command).  
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No Enable general 
"Picture In Picture" 

operations 

Enable 'Save' as PIP "Save sequence" 
options dialog 

Frames are saved as 
PIP 

 Picture In Picture" 
options dialog 

  

1 On On Yes 

2 On Off No 

3 Off On No 

4 Off Off No 

 

Table shows that frames of a video sequence are saved as PIP only if both check boxes 
(buttons, commands, menu items) are "On". Each channel, primary and assistant, has its own 
pair of these check boxes (commands).  

When frames of video sequence are saved as "Picture In Picture", inserted picture is taken from 
the video port selected for the primary / assistant channel in the "Picture In Picture" options 
dialog. See edit and spin boxes "Insert picture from the video port" in that dialog.  

"Save from video port 1(3)" and "Save primary (assistant) panel 'As Is'" radio 
buttons  

These radio button allow you to select the source of base picture (picture where another picture 
is inserted into) for PIP operations on the saved sequence.  

If "Save from video port 1(3)" radio button is checked then base picture of saved video 
sequence is taken from the video port 1 for the primary channel, or from the video port 3 for 
the assistant channel. Video port 1 is the main video output port for the primary channel, and 
video port 3 is the main video output port for the assistant channel (Channels, video ports, 
video panels). If this radio button is checked then base picture always presents video data for 
the primary or assistant channel itself.  

if "Save primary (assistant) panel 'As Is'" radio button is checked then base picture for PIP 
frames is taken from the default video panel associated with the channel (Channels, video 
ports, video panels). For the primary video channel it is the primary video panel, and for the 
assistant channel it is the assistant video panel. Any video panel can display any of 4 available 
video ports. Displayed video port for each video panel is selected by clicking buttons in the 
Controller panel.  

At first acquaintance, PIP operations with checked "Save primary (assistant) panel 'As Is'" radio 
button may seem a bit complicated. It is because it offers a variety of combinations for the 
base and inserted pictures in the PIP operations on the saved from the channel sequences. For 
each channel there are 16 combinations, including the variant used when "Save from video port 
1(3)" radio button is checked.  

The variety of combinations available when "Save primary (assistant) panel 'As Is'" radio 
button is checked, is especially useful for video editing. It allows selecting flexibly the 
appropriate variant for the multiple pass layered assembling of video sequences. 
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Remarks  

"Save sequence" operation allows to save sequences from the channels in the "Play" mode. 
Sequence can be captured in a real time from the input streams during direct "Play" operations. 
Played sequences can be saved from the both, primary or assistant, channels concurrently, or 
from the one channel only.  

The fastest way to control "Save sequence" operations during direct "Play" operation is to click 
"Enable / Disable playing" buttons in the "Go" toolbar.  

The fastest way to turn on and off "Picture In Picture" operations for the video sequences saved 
from then streaming channels during direct "Play" operation is to click "Enable / Disable 'Picture 
In Picture" buttons in the "View" toolbar. 

 

Convert file / stream from one format to another  

 

If file format of the input sequence is different from the file format of the saved (output) 
sequence then the "Save sequence" operation is essentially a "File conversion" operation.  

Breeze offers a big number of file conversion variants. See the topic supported video and image 
formats for more detailed information.  

To perform a file conversion operation it is required:  

    1. Select input sequence; video file or sequence of separate image files,  

    2. Specify parameters of a "Save sequence" operation, including file format of the file / files 
where data from the channel will be saved into,  

    3. Enable "Save sequence" operation, in the "Save sequence" options dialog,  

    4. Start playing a channel / channels.   

Use buttons in the "Go" toolbar for a faster control of a "File conversion" operations. 
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"Capture image" options dialog box 
 

 

 

This dialog allows you to enable / disable "Save captured image" operation for processed 
streams and set parameters of "Save captured image" operations.  

The following options are available in this dialog:  

"Enable 'Save captured image' operation" check box  

Enables / disables "Save captured image" operations for both channels.  

 

"Save image count" edit box  

 

This edit box allows you to set a start number which will be used as a reference for counting 
captured images. It can be reset any time to a new number.  

 

"Get and save video port 1(3) instantly" check box  
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Enable / disable instant copying of image from the main video output port to the auxiliary 
"pocket" video port and then saving of copied image to the file.  

This operation is initiated by clicking buttons "Get" in the Controller panel.  

If this check box is unchecked then captured images is just copied to the auxiliary "pocket" 
video port.  

There are two "Get" buttons in the Controller panel. Upper "Get" button initiates capture of 
image from the video port 1 to the video port 2 (primary channel). Lower "Get" button initiates 
capture of image from the video port 3 to the video port 4 (assistant channel).  

Capturing an image from the main port of the channel with a "Get" button, and instant saving 
captured image to the file is called in short "Capture image from the channel".  

"Capture image from the channel" operation is similar to the capturing an image from the video 
panel "As Is", with instant saving that captured image to file. Capture "Video panel" operations 
is initiated by clicking buttons in the "Channel" toolbar or corresponding items in the "Channel" 
menu.  

At the same time, there is a substantial difference between these two operations, between 
"Capture image from the channel", on the one hand, and "Capture video panel", on the other 
hand.  

In the case of the "Capture image from the channel" operation, image is always captured from 
the video port 1 (primary channel) or video port 3 (assistant channel) as it is generated by the 
channel itself. No filtering or "Picture In Picture" operations are applied to the captured image.  

Instead, image captured from the video panel "As Is" may present any video port currently 
selected into the video panel (see "Controller panel" topic). If filtering or "Picture In Picture" 
operations are applied to the image currently displayed in the video panel then captured image 
will reflect all those changes.  

One important usage of "Get" image operation without instant saving to the file is making 
"screen shuts" of frames from the playing video sequence in real time, and instant displaying 
them in the video panel as a sole image or as a "Picture In Picture" (base image or inserted 
image, depending of the selected configuration of Breeze).  

Also, capture image operations of both types can be used effectively together. At the first step 
image can be captured from the channel and instantly displayed as a "Picture In Picture". Then, 
at the second step, newly formed "Picture In Picture" image displayed in video panel may be 
captured from the video panel "As Is" and saved to the file.  

 

"Output folder" edit box  

 

In this edit box you have to specify full path to the folder where files containing caputred image 
will be saved.  

You can do it manually or in the "Select folder" file manager dialog . To open "Select folder" 
dialog click button "Browse..." placed to the right of the "Output folder" edit box.  

 

"File name title" group box  
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In this group box you have to specify components of file name title. That title will be used in 
the file name of saved captured images.  

 

"Prefix" edit box  

 

Specify in this edit box a prefix (the very first part) of the file name title.  

 

"Suffix" edit box  

 

Specify in this edit box a suffix (the very last part) of the file name title.  

 

"Minimum number of digits in title" edit box  

 

Specify in this edit box a minimum number of digits in the digital root (middle part) of the file 
name title.  

 

"Image file format" group box  

 

In this group box you have to specify a format of files where captured images will be saved 
into.  

 

"File name extension" edit box  

 

Use this edit box if you want to specify a file name extension different from the default file 
name extension defined for the selected file format.  

 

Remarks  

 

"Capture image" operation allows to capture images from the channels in the "View" and "Play" 
modes. Images can be captured in real time from the input streams during direct "Play", or 
during "Replay" from the frame cash buffers.  

"Capture image" operation is initiated by the clicking button "Get" in the controller panel of a 
browser window. There two "Get" buttons in the controller panel; upper one is associated with 
the primary channel, and lower one is associated with the assistant channel.  

When button "Get" is clicked, image from the main video output port of the channel is saved to 
the auxiliary "pocket" video output port of the channel.  

Image from the "pocket" video port can also be instantly saved to the file / files on the disk, if 
"Get and save image instantly" check box associated with the selected channel is checked. If 
this check box is unchecked then captured image is just saved to the "pocket video" port. 
Captured image kept in the "pocket" video port can any time be saved to the file by clicking 
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button "Save". There two "Save" buttons in the controller panel; upper one is associated with 
the primary channel, and lower one is associated with the assistant channel.  

Table below shows main and "pocket" video ports associated with the primary and assistant 
channels.  

 

 

Channel Main video 

output port No. 

"Pocket" video 

output port No. 

Primary 1 2 

Assistant 3 4 

 

If each captured image is saved to the separate file then names of files are sequentially 
numbered and ordered by the Breeze. Title of the saved file name includes prefix, digital root 
and suffix. Digital root is a fixed length text consisting of the decimal digit characters. Root is 
made by the converting an order number of the captured frame into text. During mass 
"Capture image" operations prefix and suffix are constant for all saved files, but digital root is 
changing according to the order number of the captured image.  

There are two main panels in "Capture image" dialog, upper panel and lower panel. Upper 
panel is associated with the primary channel, and lower panel is associated with the assistant 
channel. 
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"Video" options dialog box 
 

 

 

This dialog allows you to specify parameters of Breeze during playing a video.  

These parameters are applied when Breeze is in the "Play" mode, and executes "Play" and 
"Replay" operations.  

The following options allow you to specify video play parameters:  

 

"Frequency, frames / sec in" combo box  

Specify in this field a maximum frame rate (frequency) of video play / replay operations.  

This frame rate can further be reduced from the maximum value to zero by setting the "Play" 
slider in the controller pane of a browser window.  
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"Video out period, msec" text box  

This read only text box shows length in milliseconds ( 0.001 of second) of a video output period 
(length of time during which one frame is processed).  

 

 

"Synchronization of channels" group box  

Specifies in this group box how concurrently played video streams in the primary and assistant 
channel have to be synchronized.  

 

"Controller panel" group box  

Specify in this group box the parameters of a video info output in the controller panel.  

 

"Enable frame index and time info" check box  

Enable / disable real time displaying of a frame index and time info in the controller panel 
during "Play" and "Replay" operations.  

Displaying frame indexes and time info for each frame when video is playing, may slow down 
total frame rate noticeably, and especially on the computers equipped with a low speed CPU.  

It may be useful to disable displaying these parameters in the controller panel during playing a 
real time video.  

On the other hand, knowing indexes of frames and time info for each frame can be very useful 
during replaying a video from the frame cash buffers. Therefore it may be useful to enable 
displaying these parameters in the controller panel during replaying a video from the buffers. 
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"Video panel" options dialog box 

 

This dialog allows you to set image drawing parameters of video panels.  

The following options are available in this dialog:  

 

"Automatically activate a fast stretch drawing during playback of any video ('Play' 
mode)" check box  

 

If this check box is checked then system automatically switches to the fast stretch image 
drawing every time when it plays a video ("Play" mode), independently on the value set by the 
slider box "'Play" mode". Setting of that slider box is ignored.  

If this check box is unchecked then system switches to the stretch image drawing mode 
defined by the slider box "'Play' mode" when it plays a video ("Play" mode).  

 

"2D Graphics: Stretch drawing" group box  
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In this group box you may specify parameters of a stretch image drawing for viewing a 
graphics and playing a video.  

You may select a faster but lower quality, or higher quality but slower stretch drawing mode.  

 

 

"'View' mode" slider box  

 

Using this slider box you may set stretch drawing parameters for viewing a graphics ("View" 
mode of a browser window).  

 

"'Play' mode" slider box  

 

Using this slider box you may set stretch drawing parameters for playing a video ("Play" mode 
of a browser window).  

 

Remarks  

Usually drawing of image without any stretching (zooming) is noticeably simpler and faster 
than drawing of images stretched in or out relative its original 100% size. Depending on 
hardware resources and software algorithm used for stretching an image, drawing with 
stretching may from 2 to 100 times be slower than drawing of not stretched image.  

If size of images is small, video equipment is fast and there is no need to draw many image 
frames per second then more complex and slower stretch drawing algorithms are the favorite 
choice because they usually provide a noticeably better quality final stretched image.  

Problems appear when size of images becomes big, video equipment is not fast enough and 
many image frames have to be drawn every second, as it is required for playing a video. In 
that case it is quite possible that more complex drawing algorithms may be so slow that system 
can not provide a required frame rate of drawing.  

The only solution which may provide a required frame rate in that sort situations, is to use 
simpler and faster drawing algorithms, even if they provide lower quality stretched images.  

It is important to remember that there is a apparent difference between viewing a static 
individual image and watching a video sequence consisting of many image frame displayed 
every second.  

When we view a static individual image for at least several seconds, we are able to distinguish 
fine details of image, particularly we may notice, even unconsciousnessly, defects of image 
stretching. That is why high quality stretch drawing algorithms are important for viewing an 
individual image (graphics).  

When we are watching many image frames per second, our vision is not able to distinguish fine 
details of individual images in such a degree as we are able to do that when we are viewing 
just one static image. Some details and defects become almost undistinguishable.  

As a result our vision is more tolerant to the defects of image stretching when are watching a 
video, and it is more sensitive to the defects when we are viewing a static image.  
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In practical terms it means that often (not always) simpler and faster stretch drawing 
algorithms may be used for watching a video. They usually provide a good quality (good 
psychological perception) of a video.  

There are two groups of controls in "Video panel" dialog, upper group and lower group. Upper 
group is associated with the primary video panel, and lower group is associated with the 
assistant video panel. 
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"Picture In Pucture" options dialog box 

 

 

This dialog allows you to enable / disable "Picture In Picture" operations for each video panel 
and set parameters of "Picture In Picture" operations.  

The following options are available in this dialog:  

 

"Enable "Picture In Picture"" check box  

 

Enable / disable "Picture In Picture" operations for the selected video panel.  

 

"Insert picture from the video port" edit and spin boxes  

 

These control boxes allow you to specifying a video port where inserted picture is taken from.  
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"PIP rectangle: origin and size, pixels" group box  

 

Controls in this group box allow you to specify position and size of "Picture In Picture" rectange 
in "pixel" units.  

 

"Position relative to the video panel" radio button  

 

If this radio button is checked then "Picture In Picture" rectangle, its left top corner namely, will 
be positioned relative to the left top corner of the video panel.  

Values of "X Pos", "Y Pos", "Width" and "Height" are used as position and size of PIP rectangle.  

 

"Position relative to the base picture" radio button  

 

If this radio button is checked then "Picture In Picture" rectangle, its left top corner namely, will 
be positioned relative to the left top corner of the base picture (picture where PIP rectangle is 
inserted into).  

Values of "X Pos", "Y Pos", "Width" and "Height" are used as position and size of PIP rectangle.  

 

"X Pos" ans "Y Pos" edit and spin boxes  

 

These control boxes allow you to specify X and Y position of PIP rectangle in pixel units.  

If "Position relative to the video panel" radio button is checked then PIP rectangle is positioned 
relative to the video panel. If "Position relative to the base picture" radio button is checked 
then PIP rectangle is positioned relative to the base picture.  

 

"Width" and "Height" edit and spin boxes  

 

These control boxes allow you to specify width and height of PIP rectangle in pixel units.  

 

"Source picture rectangle (inserted picture)" group box  

 

Controls in this group box allow you to specify parameter of the source picture rectangle where 
inserted picture is taken from.  

 

"Entire picture" radio button  

 

If this radio button is checked then entire source picture is inserted into the "Picture In Picture" 
rectangle.  
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If this radio button is checked then values of "X Pos", "Y Pos", "Width" and "Height" defined in 
this group box are ignored.  

 

 

"Crop rectangle: origin and size, pixels" radio button  

 

If this radio button is checked then inserted picture is taken from the "crop rectangle" of the 
source image. Crop rectangle, its left top corner namely, will be positioned relative to the left 
top corner of the source image (image where crop rectangle is taken from).  

If this radio button is checked then values of "X Pos", "Y Pos", "Width" and "Height" are used as 
position and size of the crop rectangle.  

 

"X Pos" and "Y Pos" edit and spin boxes  

 

These control boxes allow you specify X and Y position of crop rectangle, its left top corner 
namely, in pixel units. Position is defined relative to the left top corner of the source image.  

These values are taken in account only if "Crop rectangle: origin and size, pixels" radio button 
is checked.  

 

"Width" and "Height" edit and spin boxes  

 

These control boxes allow you to specify width and height of crop rectangle in pixel units.  

These values are taken in account only if "Crop rectangle: origin and size, pixels" radio button 
is checked.  

 

Remarks  

 

"Picture and Picture" source image can be taken from any of 4 available video ports and 
inserted in any video panel.  

If video port is receiving data from the stopped or paused channel then inserted picture is 
static (presents no motion). If video port is receiving data from the playing channel then 
inserted picture is dynamic (presents video motion).  

Turning On and Off PIP operations can be done in the described here options dialog "Picture In 
Picture". But faster way to do that is to use buttons "Enable/Disable 'Picture In Picture" buttons 
in the "View" toolbar or in the "View" menu.  

Direct access to the "Picture In Picture" options dialog is provided by the "PIP (Picture In 
Picture) Options..." command in the "View" menu.  

There are two groups of controls in "Video panel" dialog, upper group and lower group. Upper 
group is associated with the primary video panel, and lower group is associated with the 
assistant video panel. 
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"Files of type" options dialog box 

 

 

This dialog allows you to select types of files which can be open to the channels in the "View" 
mode.  

The following options are available in this dialog:  

 

"All files" radio box  

 

If this radio box is checked then files of all types available in Breeze will be open.  

 

"All video files" radio box  

 

If this radio box is checked then files of all video types available in Breze will be open.  
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"All graphics files" radio box  

 

If this radio box is checked then files of all graphics types available in Breeze will be open.  

 

"Files of the last selected type only" radio box  

 

If this radio box is checked then only files of the type selected last time to the Breeze will be 
open. Files may be open to the Breeze with "Open", "Open To", "Recent files", "Step", "Step 
back" commands.  

 

Remarks  

 

In the "File of type" dialog you can select types of files which can be open to the channels in 
the "View" mode. Essentially it means a selection of a filter for files which can be shown in the 
video panels when "Step" and "Step back" commands are applied. These commands can be 
applied via the Go menu and Go toolbar. In the "View" mode of a browser window these 
commands are also available via the hot keys "Page Up" (Step) and "Page Down" (Step back).  

There are two panels in this dialog, upper panel and lower panel. Upper panel is associated 
with the primary channel, and lower panel is associated with the assistant channel. 
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"Set 'Save' paths" options dialog box 
 

 

 

This dialog allows you to select a path, file or folder, where video sequence will be saved.  

The following options allow you to specify a path:  

 

"Info" text box  

At the very top of the dialog there is a read only "info" text box. In that box you may see 
information inherited from the "Options" dialog "Save sequence":  

• Name of the channel where "Save" operation is implemented,  
• Format of file / files where video sequence will be saved to.  

 

"Single output file" edit box  

In this edit box you may enter a path to the file where video sequence will be saved to. You 
can type path name manually or you can select it in the file dialog. To open a file dialog click 
the button "Browse..." placed to the right of the "Single output file" edit box.  

 

"Multiple output files" group box  

In this group box you may specify the path to the folder where video sequence will be saved in 
the multiple files with just one image in each file.  

 

"Output folder for multiple image files" edit box  

In this group box you may specify the path to the folder where video sequence will be saved. 
You can type path name manually or you can select it in the file dialog. To open a file dialog 
click the button "Browse..." placed to the right of the "Output folder for multiple image files" 
edit box.  
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"File name title" group box  

In this group box you have to specify components of file name title. That title will be used in 
the file name of saved captured images.  

 

"Prefix" edit box  

Specify in this edit box a prefix (the very first part) of the file name title.  

 

"Suffix" edit box  

Specify in this edit box a suffix (the very last part) of the file name title.  

 

"Minimum number of digits in title" edit box  

Specify in this edit box a minimum number of digits in the digital root (middle part) of the file 
name title.  

 

"File name extension" edit box  

Use this edit box if you want to specify a file name extension different from the default file 
name extension defined for the selected file format.  

 

Remarks  

There are two variants of "Save" path, "Save" file and "Save" folder.  

If all frames of video sequence are saved in the single file, then you have to specify a full path 
to that "Save" file. If each frame of video sequence is saved in a separate file in the certain 
folder, then you have to specify a full path to that "Save" folder.  

The concrete variant of a "Save" operation, "Save all images in one file" or "Save each image 
as separate file", is selected in options dialog "Save sequence".  

This dialog "Set 'Save' path" is invoked from the "Save sequence" dialog, after variant of 
"Save" path is selected. Therefore Breeze "knows" which variant to use, and formats the fields 
of "Set 'Save' path" dialog correspondingly.  

If video sequence will be saved in the single file then edit box "Single output file" is enabled 
and, at the same time, all controls in the group box "Multiple output files" are disabled 
(grayed). And "vice versa", if each frame of video sequence will be saved in a separate file in 
the specified folder, then all controls in the group box "Multiple output files" are enabled, and, 
at the same time, edit box "Single output file" is disabled. 

 

 

68 

Copyright ©2008 · Discovery Scientific, LLC  
 



Options dialogs                                                                                                                           Breeze User Guide 

 

69 

Copyright ©2008 · Discovery Scientific, LLC  

"File formats: JPEG" options dialog box 
 

 

 

This dialog allows you to specify parameters of JPEG file / stream format.  

The following options allow you to specify JPEG file / stream:  

 

"Quality" slider, edit, spin boxes  

These control boxes allow you specifying a quality of the compressed JPEG image.  

 

"Color space" group box  

This group box allow you to specify color space of JPEG image.  

JPEG format allows to save color image in its original color form or convert color image into a 
gray (black and white) image. Size of a gray JPEG file is smaller than the size of a color JPEG 
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file. Using gray image may be useful when color information is not required and size of the 
JPEG file has to be as small as possible for the given level of quality.  

Remarks  

JPEG is a lossy compression algorithm. When image is converted into the JPEG format some 
color information is lost. As a result a quality of the image compressed with JPEG algorithm 
becomes lower than it was originally in the uncompressed image. The loss of a quality depends 
on the level of compression. The higher level of compression in JPEG file, the lower level of 
quality.  

Practically it means that there has to be found a compromise between quality and the level of 
compression acceptable for the concrete situation.  

Level of quality in the uncompressed image is defined as 100%. Level of quality about 80% is 
considered usually as a high. Level a quality about 50% - 60% is considered as an average. 
And level of quality about 20% - 40% is considered as a low. These estimations are 
approximate, and may be different under specific conditions. 
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"File formats: JPEG-2000" options dialog box 
 

 

 

 

 

This dialog allows you to specify parameters of JPEG-2000 file / stream format.  

The following options allow you to specify JPEG-2000 file / stream:  

 

"Color space" group box  

 

This group box allows you to specify a color space used as an internal format in the JPEG-2000 
image.  

Click a radio button in this group box to select a required color space.  
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"Bit depth" group box  

 

This group box allows you to specify a bit depth of each color component.  

Table below shows how many colors there are in the images with the different bit detpth:  

 

 

Bit depth Colors in the 
grayscale image 

Colors in the 
color palette 

image 

Colors in the color 
RGB image 

1 2 2 not applied 

2 4 4 not applied 

4 16 16 not applied 

8 256 256 16777216 

16 65536 not applied 281474976710656 

 

Click a radio button in this group box to select a required bit depth.  

 

"Compression" group box  

 

Controls in this group box allow you to specify a type of compression used in the JPEG-2000 
image. 

  

• Lossless - no color information is lose during compression  

• JP2 - lossy JP2 codec  

• JPC - lossy JPC codec  

 

"Quality" slide, edit and spin boxes allow you to specify a level of quality for JPEG-2000 
compression, from 1 to 1000.  

The higher a quality of a compressed the lower level of compression (size of compressed file is 
bigger). Usually level of quality about 100 - 300 provides very high guality final images (PSNR 
more than 40).  

At the level of quality less than 500, size of the compressed JPEG-2000 file can be estimaged 
as  

 

(Size of uncompressed image) * Quality / 1000. 

 

For example, image with a quality about 200 will be about 5 times smaller than original 
uncompressed image, and image with the quality about 100 will be about 10 times smaller.  

 

72 

Copyright ©2008 · Discovery Scientific, LLC  
 



Options dialogs                                                                                                                           Breeze User Guide 

 

73 

Copyright ©2008 · Discovery Scientific, LLC  

Remarks  

 

JPEG-200 supports lossless and lossy compression algorithms.  

If lossless compression is used then color information is not lost in the JPEG-2000 image during 
compression itself, and a quality of an image converted into the JPEG-2000 format is same as it 
was the original uncompressed image.  

There are two major exceptions from this rule. JPEG-2000 image internally may be presented 
in the different color spaces and with the different color bit depth. As a result some color 
information may be lost if during JPEG-2000 compression: 

  

• Color space of the original image is converted into another color space with a smaller 
number of color components.  

• Bit depth of the original image is reduced.  

 

For example, color information is lost when original color image is saved as a gray JPEG-2000 
image; or when original image with 8 bit color depth is saved as a 4 bit JPEG-2000 image. 
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"File formats: PNG" options dialog box 
 

 

 

 

This dialog allows you to specify parameters of PNG file / stream format.  

The following options allow you to specify PNG file / stream:  

 

"Color space" group box  

This group box allows you to specify a color space used as an internal format in the PNG image.  

Click a radio button in this group box to select a required color space.  
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"Bit depth" group box  

 

This group box allows you to specify a bit depth of each color component.  

Table below shows how many colors there are in the images with the different bit detpth:  

 

Bit depth Colors in the 
grayscale image 

Colors in the 
color palette 

image 

Colors in the color 
RGB image 

1 2 2 not applied 

2 4 4 not applied 

4 16 16 not applied 

8 256 256 16777216 

16 65536 not applied 281474976710656 

 

Click a radio button in this group box to select a required bit depth.  

 

"Interlaced" check box  

This check box allows you to specify whether internally PNG image will be save as progressive 
or interlaced.  

 

"Compression" level edit and spin boxes  

 

These control boxes allow you to specify compression level of the PNG image.  

The higher a level of compression, the smaller a size of the compressed file. But compression 
to the higer degree requires longer time.  

Minimum level of compression is 0, maximum is 9.  

At the modern PC compression of a single standard resolution image (640 x 480) is fast at all 
levels of compression. Therefore maximum compression level 9 is adequate in the majority of 
occasional situations.  

Compression time becomes noticeable when size of image is much bigger than standard 
resolution, or when multiple images have to be compressed in real time. For example, when 
PNG format is used for saving a video stream to the hard disk. In that case a lower level of 
compression may be useful.  
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Remarks  

 

PNG is a lossless compression algorithm. It means that color information is not lost in the PNG 
image, and a quality of an image converted into the PNG format is same as it was the original 
uncompressed image.  

There are two major exceptions from this rule. PNG image internally may be presented in the 
different color spaces and with the different color bit depth. As a result some color information 
may be lost if during PNG compression:  

 

• Color space of the original image is converted into another color space with a smaller 
number of color components.  

• Bit depth of the original image is reduced.  

 

For exampe, color information is lost when original color image is saved as a gray PNG image; 
or when original image with 8 bit color depth is saved as a 4 bit PNG image. 
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"File formats: GIF" options dialog box 
 

 

 

 

 

This dialog allows you to specify parameters of GIF file / stream format.  

The following options allow you to specify GIF file / stream:  

 

"Color space" group box  

 

This group box allows you to specify a color space used as an internal format in the GIF image.  

Click a radio button in this group box to select a required color space.  
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"Bit depth" group box  

 

This group box allows you to specify a bit depth of each color component.  

Table below shows how many colors there are in the images with the different bit detpth:  

 

 

Bit depth Colors in the 
grayscale image 

Colors in the 
color palette 

image 
1 2 2 

2 4 4 

4 16 16 

8 256 256 

 

Click a radio button in this group box to select a required bit depth.  

 

 

"Palette" group box  

 

This group box allows you to specify parameters of algorithms used to build a palette when 
"Color palette" radio button in the "Color space" group box is checked.  

if "Standard halftone" radio button is checked then palletized images are made with the 
standard for Windows operating system halftone palette. This method is fast but colors of that 
palette are not optimal for concrete images.  

If "Optimal adaptive octree" radio button is checked then palletized images are made with the 
adaptive octree palette (Gervautz-Purgathofer octree algorithm). This method is slower but 
colors of that palette are adaptively selected for every concrete image. As a result quality of a 
final image is usually much higher.  

"Significant color bits" edit and spin boxes allow setting a number of color bits used in the 
octree algorithm. Usually from 4 to 6 bits are enough to make a good quality palette. 
Increasing number of bits to 7 and 8 does not usually improve noticeably quality of palette. 
Best palette is made when the maximum number of significant bits, 8, But using a bigger 
number of bits makes calculations slower.  

 

"Interlaced" check box  

 

This check box allows you to specify whether internally PNG image will be save as progressive 
or interlaced.  
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Remarks  

 

GIF file format uses a lossless compression algorithm. It means that color information is not 
lost in the GIF image during compression itself, and a quality of an image converted into the 
GIF format may be the same as it was the original uncompressed image.  

There are two major exceptions from this rule. GIF image internally may be presented in the 
different color spaces and with the different color bit depth. As a result some color information 
may be lost if during GIF compression:  

Color space of the original image is converted into another color space with a smaller number 
of color components.  

Bit depth of the original image is reduced.  

GIF color images contain no more than 256 colors. Therefore color information is lost when 24 
bit RGB image is saved as a GIF. Also color information is lost when original color image is 
saved as a gray GIF image; or when original image with 8 bit color depth is saved as a 4 bit 
GIF image. 

 

 



Breeze User Guide                                                                                                                           Options dialogs 
 

"File formats: TIFF" options dialog box 
 

 

 

 

This dialog allows you to specify parameters of TIFF file / stream format.  

The following options allow you to specify TIFF file / stream:  

 

"Color space" group box  

 

This group box allows you to specify a color space used as an internal format in the TIFF 
image.  

Click a radio button in this group box to select a required color space.  
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"Bit depth" group box  

 

This group box allows you to specify a bit depth of each color component.  

Table below shows how many colors there are in the images with the different bit detpth:  

 

 

Bit depth Colors in the 
grayscale image 

Colors in the 
color palette 

image 

Colors in the color 
RGB image 

1 2 2 not applied 

2 4 4 not applied 

4 16 16 not applied 

8 256 256 16777216 

16 65536 not applied 281474976710656 

 

 

Click a radio button in this group box to select a required bit depth.  

 

 

"Palette" group box  

 

This group box allows you to specify parameters of algorithms used to build a palette when 
"Color palette" radio button in the "Color space" group box is checked.  

if "Standard halftone" radio button is checked then palletized images are made with the 
standard for Windows operating system halftone palette. This method is fast but colors of that 
palette are not optimal for concrete images.  

If "Optimal adaptive octree" radio button is checked then palletized images are made with the 
adaptive octree palette (Gervautz-Purgathofer octree algorithm). This method is slower but 
colors of that palette are adaptively selected for every concrete image. As a result quality of a 
final image is usually much higher.  

"Significant color bits" edit and spin boxes allow setting a number of color bits used in the 
octree algorithm. Usually from 4 to 6 bits are enough to make a good quality palette. 
Increasing number of bits to 7 and 8 does not usually improve noticeably quality of palette. 
Best palette is made when the maximum number of significant bits, 8, But using a bigger 
number of bits makes calculations slower.  
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"Compression" group box  

 

Controls in this group box allow you to specify a type of compression used in the TIFF image.  

 

• None - no compression is used (uncompressed data)  

• LZW - lossless compression ((Lempel-Ziv-Welch algorithm)  

• Packbits - lossless compression  

• ZIP - lossless compression  

• JPEG - lossy compression  

• Huffman RLE - lossless compression  

• CCITT Fax 3 - lossless compression  

• CCITT Fax 4 - lossless compression  

 

"Quality" slide, edit and spin boxes allow you to specify a level of quality for JPEG compression.  

"Huffman RLE", "CCITT Fax 3" and "CCITT Fax 4" compressions can be used with monochrome 
images only.  

 

Remarks  

 

TIFF supports a number of lossless and lossy compression algorithms.  

If lossless compression is used then color information is not lost in the TIFF image during 
compression itself, and a quality of an image converted into the TIFF format is same as it was 
the original uncompressed image.  

There are two major exceptions from this rule. TIFF image internally may be presented in the 
different color spaces and with the different color bit depth. As a result some color information 
may be lost if during TIFF compression: 

  

• Color space of the original image is converted into another color space with a smaller 
number of color components.  

• Bit depth of the original image is reduced.  

 

For example, color information is lost when original color image is saved as a gray TIFF image; 
or when original image with 8 bit color depth is saved as a 4 bit TIFF image. 
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"File formats: YUV" options dialog box 
 

 

 

This dialog allows you to specify parameters of YUV format file / stream.  

For additional information about YUV formats please visit section FAQ (Frequently Asked 
Questions) at the Breeze support web site www.DiscoveryBiz.Net  

The following options allow you to specify YUV file / stream:  

 

"Data format" combo box  

This combo box allows specifying YUV image format entirely.  

If you know exactly the name of required format then you can select it from the full list in this 
combo box.  
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The list of displayed YUV formats depends on the filter values selected in the other combo 
boxes, placed under "Data format" combo box.  

All available formats are displayed in the list when values of filters are set to "Any" value. It 
means that YUV format is specified in general only.  

To make specification more definite, filters have to be set to the concrete values. As a result, a 
list of YUV formats displayed in the "Data format" combo box becomes shorter. The more filters 
are set to the definite values, the more precisely YUV format is defined.  

"RGB-YUV conversion base" combo box  

This combo box specifies an RGB-YUV conversion base.  

Conversion base is defined, first of all, by the formulae coefficients. Breeze supports major 
international standards specifying RGB - YUV conversion.  

 

"YUV color components" combo box  

This combo box specifies YUV color componets as they are defined in the concrete YUV color 
spaces.  

 

"Sub sampling ratio" combo box  

This combo box specifies sub sampling ratio for chroma color components.  

 

"Color planes" combo box  

This combo box specifies a structure of color planes and how individual colors of each pixel 
placed in the color planes.  

There are two major variants, planar and interleaved. In the first variant data describing a 
color component are saved in one continious array. For 3 color components 3 color planes are 
used. In the second variant all color componets describing one pixel are kept together, one 
after another. In this variant only one inteleaved color plane is used.  

 

"Progressive / Interlaced" combo box  

This combo box specifies a frame scan structure.  

Entire horizontal line of pixels is called image scan line. Hardware equipment usually scans 
images line by line; in a whole scan line units. There are two major variants of scanning image, 
progressive and interlaced.  

In the progressive scan scheme an image is scanned entirely, line by line.  

In the interlaced scheme an image is scanned in two stages, even and odd. At the even stage 
all even lines of image are scanned; then at the odd stage all odd lines are scanned. These two 
sub groups of scan lines are usually saved separately. When image is restored for displaying to 
a user, scan lines from the even and odd sub groups are joint in one image by the special 
procedure called "deinterlacing"  

 

"Bits per luma" combo box  

This combo box specifies how many bits per luma color component is used to represent data 
for one pixel.  
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"Bits per chroma" combo box  

This combo box specifies how many bits per chroma color component is used to represent data 
for one pixel.  

 

"Data range" combo box  

This combo box specifies the range of values used to represent luma and chroma withing limits 
of minimum and maximum values.  

For example, if 8 bits is reserved for luma and chroma color components, then the minimum 
value is 0, and maximum value is 255. At the same time concrete YUV format may require 
using more narrow range of values, for example 16 - 235 for luma, 16 - 240 for both chromas.  

 

"Sub sampling pattern" combo box  

This combo box specifies a pattern of sub sampled chroma components.  

 

"Single image in file" combo box  

This combo box specifies how a sequence of YUV images is organized, as a one file / stream 
with multiple images in it, or as a multiple file with the single image in each file.  

 

"Size of the image" group box  

This group box allow you to specify size (resolution) of the YUV image.  

 

"Resolution" combo box  

This combo box allows you to make a selection from the list of major standard resolutions, or 
to specify custom sizes of the image. 

 

"Width" and "Height" edit boxes  

These edit boxes allow you to specify width and height of the image if you have selected a 
"custom resolution" in the "Resolution" combo box.  

 

Remarks  

YUV files / streams are specified by the following main parameters:  

1. YUV image format itself:  

• RGB - YUV conversion base (formulae coefficients)  
• Type of YUV color components  
• Sub sampling ratio  
• Structure of color planes, planar or interleaved  
• Frame scan structure, progressive or interlaced  
• Luma bit depth  
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• Chroma bit depth  
• Data range for each color component  
• Sub sampling pattern  

2. Size of YUV image, width and height  

3. Number of images in file / stream, single or multiple).  

 

What is YUV?  

YUV color model imitates a human vision. Humans are able to recognize (discern) the contents 
of a color RGB (Red / Green / Blue) image presented in the two main forms, as an original RGB 
color image or as a gray (black / white) image.  

Historically, YUV color space was developed to provide compatibility between color and black 
/white analog television systems. YUV color image information transmitted in the TV signal 
allows proper reproducing an image contents at the both types of TV receivers, at the color TV 
sets as well as at the black / white TV sets.  

Term YUV itself is not defined precisely in the technical and scientific literature. In general it 
designates a whole family of so called luminance / chrominance color spaces. The best way to 
avoid ambiguity associated with the term YUV is to refer to the concrete variant of YUV colors 
space well defined in the internationally recognized standard documents.  

YCbCr color space is defined in the ITU-R BT.601-5 and ITU-R BT.709-5 standards of ITU 
(International Telecommunication Union). These documents define YCbCr as a color space for 
digital television systems. These documents give concrete definitions for coefficients of 
conversion between RGB and YCbCr color spaces, for normalization and quantization of digital 
signals. A majority of parameters defined for the digital YCbCr color space remains the same 
for the YPbPr color space used in the analog television systems. YCbCr and YPbPr color spaces 
are closely related.  

Individual color components of YCbCr color space are luma Y, chroma Cb and chroma Cr. 
Chroma Cb corresponds to the U color component, and chroma Cr corresponds to the V 
component of a general YUV color space. 
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"Reference frames" options dialog box 
 

 

 

This dialog allows you to set start and stop reference frames used for playing a fragment of 
video sequence.  

The following options allow you to set reference frames for the primary and assistant channels:  

 

"Start frame" and "Stop frame" edit boxes  

Specify in these fields order numbers of the start reference frame and stop reference frame.  

 

Remarks  

If channel is open, and playing for channels is enabled, and command "Start" is applied then 
video sequence begin to play. All frames placed within video sequence before start reference 
frame are skipped as fast as possible. Skipped frames are not displayed in the browser window.  

Beginning from the start reference frame video sequence is played with normal speed and all 
frames are displayed in the browser window, until the stop reference frame is reached.  

Playing is stopped when stop reference frame is reached.  

To play very long video sequence without stops, set stop frame to some big number. Default 
value set by Breeze is 1,000,000,000. That value allows to play video at the frame rate 30 
frames per second during 1 year and 3 months without stops.  

Start and stop frames can also be set in the "Read stream" options dialog available via the 
main menu item "Options..." . 
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6. "File manager" dialog boxes 
 

"Options" dialog boxes provides you select files and folders, as well as to open and save 
documents, files and streams.  

 

Currently Breeze supports the following "File manager" dialogs: 

 

Open/Open To This dialog allows you to open file 

Open URL This dialog allows you to open file / stream with the given URL. 

Open Device This dialog allows you to open and start using a media device 

SaveAs The following options allow you to specify the name and location of the file 
you're about to save. 

Select folder This dialog allows you to enable / disable reading of input streams and set 
their parameters. 

Close From This dialog allows you to enable / disable reading of input streams and set 
their parameters 
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File "Open" / "Open To" dialog box 
 

 

 

The following options allow you to specify which file to open:  

 

"File Name" combo box  

Specifies the file you want to open. This box lists files with the extension you select in the Files 
of Type field.  

 

"Files of type" combo box  

Specifies the type of file / stream you want to open.  

 

"Open To" combo box  

Specifies the channel where file / stream will be open to.  
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"Details" check box  

This checkbox specifies whether to use info and preview panels of File dialog box (turn On / 
Off) when cursor in the file list window is set to the new position.  

When info and preview functions are turned off, scrolling through the file list is faster. Usually 
info and preview operations are so fast that is it difficult to notice difference between speed of 
scrolling in checked and unchecked states. An impact of image preview operation is noticeable 
only when sizes of images displayed in the preview window are very big, or if files / streams 
are accessed at the remote computer via network with a low data access speed.  

 

"Options..." button  

Click this button, if it is enabled, to open a dialog where you can specify details of data format, 
data access etc. for the currently selected file / stream.  

There are exists popular file / stream data formats which can not be identified precisely by the 
specific signature information kept in the file name, file name extension, in the the file header 
contents etc. Often signature or file name extension information allows identifying a general 
type only of a file data format. As a result those files / streams can not be recognized and 
visualized properly. For example, there exists hundreds YUV video and image formats with the 
same "yuv" file extension.  

Breeze recognizes a number of that sort situations and offer the user an option to specify data 
format. When such file / stream is selected, Breeze enables the "Options..." button, and you 
can access dialog where details of data format for the selected file / stream can be specified. 
Picture in the preview panel is changed according to the specifications set in the dialog.  

 

"Look in" combo box  

Specifies network address, computer, drive, directory etc. where you may look for file / 
streams.  

 

Drives  

Specifies the drive in which Breeze stores the file that you want to open.  

 

Directories  

Specifies the directory in which Breeze stores the file that you want to open.  

 

Network  

Click this button to connect to a network location, assigning it a new drive letter. 
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"Open URL" dialog box 
 

 

 

This dialog allows you to open file / stream with the given URL.  

 

The following options specify which URL (file, stream, etc.) to open:  

 

"Address" edit box and combo box  

 

Specify the URL (file, stream, etc.) you want to open.  

 

Enter required URL into the edit box:  

• Manually  

• From the list of recently used URL in the attached URL combo box  

• From the file "Open To" dialog box, accessible via the "Browse..." button  

• Via "Copy-Paste".  

 

Attached URL combo box lists several recently used URLs. Click "Down Arrow" to access that 
list.  

 

Click button "Browse..." to access file dialog "Open To".  
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"Open To" combo box  

 

Specifies the channel where file / stream will be open to.  

 

"Browse..." button  

 

Click this button to open a file "OpenTo" dialog where you can select a file / stream from the 
local computer of local network.  

 

Remarks  

 

Abbreviation URL designates a "Unified Resource Locator", also formerly known as a "Universal 
Resource Locator". URL is a universal address of some resource, like file, stream, device etc., 
at your computer, local network (intranet) or at the Internet.  

 

Breeze allows playing video from sources placed at the local computer and at the Internet. See 
the list of supported media (video / audio) formats at the Breeze built-in help page "Supported 
media (video, audio, image) formats and media devices". Please note that not all video formats 
can be used for direct video streaming from the internet. Some video formats require files to to 
be downloaded completely to the local computer first, and only after that files can be open and 
played. To play video from the local file use menu command "File.OpenTo". To play video from 
the Internet use menu command "File.OpenURL". URL has to be a FULL internet address of 
video source, including protocol type, like HTTP, HTTPS or FTP. For example:  

 

• File at the local computer: c:\video\movie.avi  

• File / stream at the Internet: http://DiscoveryBiz.net/video/a.flv  

 

To start playing video after video stream is open, click the button "Start" in the toolbar, or item 
of main menu "Go.Start", or items "Start" in pop-up menu invoked by right mouse click, or hot 
key (Ctrl - Enter).  

 

92 

Copyright ©2008 · Discovery Scientific, LLC  
 



"File manager" dialog boxes                                                                                                        Breeze User Guide 

 

93 

Copyright ©2008 · Discovery Scientific, LLC  

"Open device" dialog box 
 

 

 

This dialog allows you to open and start using a media device.  

 

The following options specify which media device to open:  

 

"Device" combo box  

 

Specifies the name of the device you want to open. This box lists active media devices ready to 
be open at the current time. Click "Down Arrow" to access that list.  

 

"Device name" is often called a "Friendly Name" of device. If several similar or same type 
devices are presented in the computer system, for example several same type webcams, they 
may have the same friendly name. Note that in the list of device friendly names, individual 
devices are distinguished by their order number placed at the very beginning of each "Friendly 
name".  
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"Open To" combo box  

 

Specifies the channel where file / stream will be open to.  

 

"DevicePath" text box  

 

This combo box shows unique string value characterizing each individual media device in the 
computer system. If that string is too long it may not fit in the text box. Click text box and 
srcoll it to the left and right to see the whole string.  

 

"Description" text box  

 

Some media devices (but not all) may also provide additional information about their 
properties. It is called "Description" of device. Similar type devices may have the same 
"Description".  
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File Save / Save As dialog box 
 

 

 

The following options allow you to specify the name and location of the file you're about to 
save:  

 

"File Name" combo box  

Specifies a file name to save a document with a different name. Breeze adds the extension you 
specify in the Save As type box.  

 

"Save as type" combo box  

Specifies the type of file / stream format which will be used to save a document.  

 

"Save from" combo box  

Specifies the channel where file / stream will be saved from.  

 

"Options..." button  

Click this button, if it is enabled, to open a dialog where you can specify details of data format, 
data access etc. for the currently selected file / stream.  
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Currently Breeze allows to specify JPEG, JPEG2000, PNG, GIF, TIFF formats.  

 

 

 

"Look in" combo box  

Specifies network address, computer, drive, directory etc. where file / stream will be saved at.  

 

Drives  

Specifies the drive in which you want to store the document.  

 

Directories  

Specifies the directory in which you want to store the document.  

 

Network  

Click this button to connect to a network location, assigning it a new drive letter. 
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Select folder dialog box 
 

 

 

This dialog allows you to select a folder.  

Folder can be selected from the folder list, from the history list attached to the combo box 
Folder name, entered manually in the edit box Folder name, or pasted to that edit box from the 
clipboard.  

The following options allow you to specify which folder to open:  

 

"Look in" combo box  

Specifies network address, computer, drive, directory etc. where you may look for a folder.  

 

Drives  

Specifies the drive where you may look for a folder.  

 

Directories  

Specifies the directory where you may look for a folder..  

 

Network  

Click this button to connect to a network location, assigning it a new drive letter. 
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"Close From" dialog box 
 

 

 

This dialog allows you to close data stream from the channel of the open browser window.  

This dialog is accessed via the File menu command Close From.  

Close From does not close browser window itself.  

If only one channel, primary or assistant, is open then Breeze closes that open channel.  

If both channels, primary and assistant, are open, then Breeze displays "Close From" dialog 
where you can select which channel has to be closed. Make a selection and click button "OK" if 
you want to close selected channels, or click button "Cancel" if you want to cancel Close From 
operation. 
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Controller panel of a browser window 
 

Controller panel allows you to monitor and configure 
several important features of the Breeze.  

 

"Mode" text boxes  

These text boxes show current operational modes for 
the primary and assistant channel of a browser 
window.  

 

"Play" text boxes  

These text boxes indicates whether playing is 
enabled or not in the primary and assistant channel.  

 

For details see commands: "Play primary channel" 
and "Play assistant channel".  

 

"Reverse" text boxes  

These text boxes indicates whether reverse playing 
direction is enabled or not in the primary and 
assistant channel.  

For details see commands: "Reverse primary 
channel" and "Reverse assistant channel".  

 

"Save" text boxes  

These text boxes indicates whether "Save" operation is enabled or not in the primary and 
assistant channel.  

For details see commands: "Save primary channel" and "Save assistant channel".  

 

"Video ports" buttons  

These buttons allow you to select video ports which will be connected to the primary and 
assistant video panels.  

Upper row of buttons connect selected video port to the primary video panel and lower row of 
button connects selected video port to the assistant video panel.  

Any of 4 video ports can be connected to any video panel .  

 

"Frame" text boxes  

These text boxes display order numbers of the currently processed frames in the primary and 
assistant channels.  

"Frame" text boxes are used when browser window is in the "Play" mode.  
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There are 4 "Frame" text boxes aligned in the column. They corresponds to the video ports 1, 
2, 3, 4.  

"Frame" text boxes 1 and 3 show order numbers of frames in the video output ports 1 and 3, 
used for the major video output operations. "Frame" text boxes 2 and 4 show order numbers of 
frames in the video output ports 2 and 4, used for the auxiliary video output operations.  

For example, auxiliary video output ports 2 and 4, and corresponding to them auxiliary "Frame" 
text boxes 2 and 4, are used for "Capture image" operations. "Frame" text boxes 2 and 4 show 
order number of the captured frames.  

Displaying a frame index and time info in the controller panel can be disabled. To do that 
uncheck a check box "Enable frame index and time info" in the "Video" options dialog.  

 

"Time" text boxes  

These text boxes display relative time of the currently processed frames in the primary and 
assistant channels.  

"Time" text boxes are used when browser window is in the "Play" mode.  

There are 4 "Time" text boxes aligned in the column. They corresponds to the video ports 1, 2, 
3, 4.  

"Time" text boxes 1 and 3 show relative time for the frames processed in the video output 
ports 1 and 3, used for the major video output operations. "Time" text boxes 2 and 4 show 
relative time for the frames processed in the video output ports 2 and 4, used for the auxiliary 
video output operations.  

Relative time is calculated relative to the very start of playing a video with the frame rate 
selected in the "Video" options dialog. It is assumed that the order number of the very first 
frame is 0. For example for the frame rate 25 frames per second, frame number 24 
corresponds to the moment of the time 1 second since the very start of playing a video 
sequence.  

Displaying a frame index and time info in the controller panel can be disabled. To do that 
uncheck a check box "Enable frame index and time info" in the "Video" options dialog.  

 

"Get" and "Save" buttons  

These buttons allows you to capture images from the channels in the "Play" mode.  

For more detailed information about "Capture image" operations see the section "Remarks" in 
the help topic "Capture image" options dialog.  

Upper buttons "Get" and "Save" are used for capturing an image from the primary channel. 
Lower buttons "Get" and "Save" are used for capturing an image from the assistant channel.  

 

"Play" slider  

You may use this slider to regulate frame rate of playing a video.  

Real frame rate of playing a video, set in the "Video" options dialog, can be reduced from the 
maximum value to zero by setting the "Play" slider.  

 

"Set" slider 
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This slider allows you to set a position for the currently processed frame in the frame cash 
buffers.  

"Audio" slider 

This slider allows you to set a level of audio output.  

 

Remarks 

Currently controls in the controller panel of a browser window are organized in 4 groups:  

• Text boxes indicating operational modes and state of the primary and assistant 
channels: "Mode", "Play", "Reverse", "Save".  

• Buttons allowing to select a video output port which will be connected to the primary 
and assistant video panels.  

• Text boxes displaying order numbers of the currently processed frames and relative 
time for those frames; each line include buttons allowing to capture processed images 
from the video panels  

• Sliders allowing to set:  

o Frame rate for playing a video,  
o Position in the frame cash buffers,  
o Level of audio out. 
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7. Using Breeze 

 

"Save video sequence" operation 
 

"Save sequence" operation allows to save sequences from the channels in the "Play" mode. 
Sequence can be captured in a real time from the input streams during direct "Play" operations. 
Played sequences can be saved from the both, primary or assistant, channels concurrently, or 
from the one channel only.  

The fastest way to control "Save sequence" operations during direct "Play" operation is to click 
"Enable / Disable playing" buttons in the "Go" toolbar.  

The fastest way to turn on and off "Picture In Picture" operations for the video sequences saved 
from then streaming channels during direct "Play" operation is to click "Enable / Disable 'Picture 
In Picture" buttons in the "View" toolbar.  

 

Convert file / stream from one format to another  

 

If file format of the input sequence is different from the file format of the saved (output) 
sequence then the "Save sequence" operation is essentially a "File conversion" operation.  

Breeze offers a big number of file conversion variants. See the topic supported video and image 
formats for more detailed information.  

To perform a file conversion operation it is required:  

Select input sequence; video file or sequence of separate image files,  

Specify parameters of a "Save sequence" operation, including file format of the file / files where 
data from the channel will be saved into,  

Enable "Save sequence" operation, in the "Save sequence" options dialog,  

Start playing a channel / channels.   

Use buttons in the "Go" toolbar for a faster control of a "File conversion" operations. 

 

 

"Capture video panel" operation 
 

Use this command to capture a picture from the primary or assistant video panel to the file.  

Capture "Video panel" operations is initiated by clicking buttons in the "Channel" toolbar or 
corresponding items in the "Channel" menu.  

Video panel is captured "As Is". Any video port can be selected into the video panel (see 
"Controller panel" topic). If filtering or "Picture In Picture" operations are applied to the image 
currently displayed in the video panel then captured image will reflect all those changes  

Options dialog "Capture image" is used for enabling / disabling and setting parameters of 
"Capture video panel" operations. 
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"Capture image from the channel" operation 
 

 

"Capture image from the channel" operation allows to capture images from the main video 
output ports of channels.  

Images can be captured when Breeze browser window is in the "View" mode, as well as when it 
is in the "Play" mode. In the "Play" mode images can be captured in real time during play back. 
During direct "Playing" images are captured from the input streams. During "Replaying" images 
are captured from the frame cash buffers.  

"Capture image" operation is initiated by the clicking button "Get" in the controller panel of a 
browser window. There two "Get" buttons in the controller panel; upper one is associated with 
the primary channel, and lower one is associated with the assistant channel.  

When button "Get" is clicked, image from the main video output port of the channel is saved to 
the auxiliary "pocket" video output port of the channel.  

Image from the "pocket" video port can also be instantly saved to the file / files on the disk, if 
"Get and save image instantly" check box associated with the selected channel is checked. If 
this check box is unchecked then captured image is just saved to the "pocket video" port. 
Captured image kept in the "pocket" video port can any time be saved to the file by clicking 
button "Save". There two "Save" buttons in the controller panel; upper one is associated with 
the primary channel, and lower one is associated with the assistant channel.  

Table below shows main and "pocket" video ports associated with the primary and assistant 
channels.  

 

Channel Main video 

output port No. 

"Pocket" video 

output port No. 

Primary 1 2 

Assistant 3 4 

 

If each captured image is saved to the separate file then names of files are sequentially 
numbered and ordered by the Breeze. Title of the saved file name includes prefix, digital root 
and suffix. Digital root is a fixed length text consisting of the decimal digit characters. Root is 
made by the converting an order number of the captured frame into text. During mass 
"Capture image" operations prefix and suffix are constant for all saved files, but digital root is 
changing according to the order number of the captured image.  

There are two main panels in "Capture image" dialog, upper panel and lower panel. Upper 
panel is associated with the primary channel, and lower panel is associated with the assistant 
channel.  

Options dialog "Capture image" is used for enabling / disabling and setting parameters of 
"Capture image from the channel" operations. 
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"Picture In Picture" operation 
 

What is a "Picture In Picture"? ......................................................... 104 
Picture In Picture" in Breeze............................................................ 104 
"Picture In Picture" in "View" and "Play" modes.................................. 105 
"Picture In Picture" video editing...................................................... 105 
Example of PIP video editing - learn it "step by step".......................... 107 

 
 

What is a "Picture In Picture"? 
 

Term "Picture In Picture" designates image, video sequence or image operation where resulting 
image or video sequence is assembled of two or more images or video sequences. One of those 
images / video sequences is called a "base": base image or base video sequences. Others 
images and video sequences are called "insertion": inserted image or inserted video sequence 
(see Figure 1). 

 

Figure 1 

 

 

Picture In Picture" in Breeze  
 

In Breeze "Picture In Picture" can be used in in all modes: "View" / "Slide Show", "Play" / 
"Replay", "Edit", "Convert".  

Base "Picture In Picture" image can be taken from any of 4 available video ports and displayed 
in any video panel, primary or assistant.  

Similarly, inserted "Picture In Picture" image can aslo be taken from any of 4 available video 
ports and displayed in any video panel, primary or assistant.  

If video port is receiving data from the stopped or paused channel then displayed picture is 
static (presents no motion). If video port is receiving data from the playing channel then 
displayed picture is dynamic (presents video motion).  

Inserted picture may present the whole source image where it is taken from or may be cropped 
of it, so it will be just a part of source image. Size of the image inserted into the base picture 
can also be adjusted.  

Parameters of PIP operations can be set in the in the options dialog "Picture In Picture". It is 
accessed via the "Tools" menu or directly via the "PIP (Picture In Picture) Options..." command 
in the "View" menu.  
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Turning On and Off PIP operations can be done in the options dialog "Picture In Picture". But a 
faster way to do that is to use buttons "Enable/Disable 'Picture In Picture" buttons in the "View" 
toolbar or in the "View" menu.  

 

 

"Picture In Picture" in "View" and "Play" modes  
 

2 streams of video data can be merged into PIP image in a number of variants. As static picture 
in static, static in dynamic, dynamic in static, dynamic in dynamic. From any of 4 video ports 
available, in any combinations. Video stream played forward can be inserted as PIP into the 
base video stream played forward, or backward in forward, forward in backward, backward in 
backward. Etc. 

PIP images can be captured on the "fly" in "View" (graphics) and "Play" (video playback) modes  

Any video panel can be captured "As is", as PIP, and saved to the file instantly by clicking 
buttons in the "Channel" tool bar or "Channel" menu. Video data from the playing / replaying 
video channels can be saved to the file as PIP video sequence. Images captured from the 
channels with buttons "Get" in the control panel can be displayed as PIP instantly. Images 
copied from the different video ports or external applications can be pasted instantly to any 
video port and instantly displayed or saved as PIP. Any text prepared in the external 
applications and converted into MS bitmap format, can be pasted to any video port and 
instantly merged into the PIP.  

2 streams of video sequences can be merged and save to the file as a "Picture In Picture". PIP 
video streams can be save to the external file or files in a number of formats. Video data saved 
to the file(s) during playback of primary / assistant channel may correspond to the video data 
in the primary / assistant video panel "As is", or be built on the base of video data from the 
channel itself.  

 

"Picture In Picture" video editing  
 

All mentioned above capabilities can be used for multi pass layered "Picture In Picture" 
assembling of video sequences. Saving merged from 2 streams PIP video sequences to the file 
can be repeated sequentially with different PIP configuration setting and different source 
streams. It allows editing and assembling rather complex multi layered PIP video sequences. 
(see Figure 2). 

 

Figure 2 
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Sequential layers of images are gradually assembled in the required Z-order (vertical order). 
Inserted images can be placed in the different areas of base image, can be nested within each 
other, or can overlapped.  

At the Figure 3 you may see an example of the image from the video sequence assembled as a 
layered "Picture In Picture". 

 

Figure 3 

 

 

Finally assembled image (video sequence) consists of 8 individual images. In total it required 7 
cycles of merging images into the "Picture In Picture".  

In general there are two main ways to assemble multi part PIP image or video sequence. It can 
be done pure sequentially or sequentially-parallel.  

In pure sequential method every new inserted image is laid out on the top of the previously 
made PIP image.  

In sequentially-parallel method, at the first stage some closely related to each other images are 
assembled into the PIP sub groups. Then, at the second stage, already grouped PIP images are 
assemble into the final PIP image (video sequence).  
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For example, at the shown above picture (Figure 3), 3 images of talking persons were inserted 
at the first stage into the frames. Then framed images were sequentially inserted into the base 
picture.  

 

Example of PIP video editing - learn it "step by step"  
 

More detailed description of "Picture In Picture" video editing you may find at the Breeze 
support web site at the www.DiscoveryBiz.net.  

On-line "Picture In Picture" HTML help can be found in the section "Frequently Asked 
Questions".  

"Picture In Pucture Guide" in *.pdf format can be found in the section "Documentaion"  

Download source and processed video data for "step by step" example  

Both, on-line "Picture In Picture" HTML help and "Picture In Pucture Guide" give description of 
Breeze settings and operations required for PIP layered video assembly editing. An example of 
layered assembling for the concrete video sequence is also included. That example gives 
detailed "step by step" description of all operations. Source images for that example, 
intermediate frames and finally assembled frames for that example can be downloaded from 
the Breeze support website. Links to the downloads can be found at the start page of the on-
line "Picture In Picture" HTML help see: "Frequently Asked Questions". 

 

 

www.DiscoveryBiz.net
http://www.discoverybiz.net/enu0/dbzn/faq.htm
http://www.discoverybiz.net/enu0/dbzn/faq.htm
http://www.discoverybiz.net/enu0/dbzn/d_sheet.htm
http://www.discoverybiz.net/enu0/dbzn/faq.htm
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8. Install/Uninstall/Repair/Activate 

Install the Breeze 

 

Breeze installation package is available for downloading at the 
www.DiscoveryBiz.Net.  
It is a single executable file, presenting self extractable compressed archive, encoded 
with password.  

Name of the Breeze, Light Edition downloadable file is "Breeze_5.5.0.L.exe" or 
similar. Name of the Breeze, Standard Edition downloadable file is 
"Breeze_5.5.0.S_DF.exe" or similar.  

Further in the text a downloadable executable archive file will be called 
Breeze_5x.exe.  

Breeze package can be installed only if a proper password, called "Serial number" is 
available.  

Serial number required to install Breeze software will be sent at you e-mail address 
by the customer support service.  

There are also available versions of Breeze with the preset serial number. Those 
versions do not require user to enter a serial number during installation.  

During installation setup program displays several dialogs where user can modify 
default configuration parameters of the installed Breeze software package.  

Installation "Step by step"  

1. Locate setup file "Breeze_5.exe" and start it.  

2. Program starts and displays the very first dialog titled "Welcome to the Breeze 
Software Wizard".  

Read instructions displayed in the dialog and then click button "Next" if you want to 
continue installation or click button "Cancel" if you want to cancel installation.  
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3. Dialog "License Agreement" is displayed.  

Read "License Agreement" and select one of the buttons "I do not agree" or "I 
agree".  

Click button "Next" if you want to continue installation or click button "Cancel" if you 
want to cancel installation.  
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4. Dialog "Customer information" is displayed.  

Enter customer data and serial number if it is required. If you are installing a version 
of the Breeze software with a preset serial number then that serial number will be 
displayed in the "Serial number" edit boxes.  

Click button "Next" if you want to continue installation or click button "Cancel" if you 
want to cancel installation.  

If entered (or preset) serial number is correct then installation program will continue 
installation. If serial number is incorrect the installation program will display a 
warning, and return you to the "Customer information" dialog. 
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5. "Select installation folder" dialog is displayed.  

Select a folder where you want to install Breeze software or use default value.  

Select variant of installation, "Everyone" or "Just me".  

Click button "Next" if you want to continue installation or click button "Cancel" if you 
want to cancel installation.  
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6. "Confirm installation" dialog is displayed.  

 

 
 

Click button "Next" if you want to continue installation or click button "Cancel" if you 
want to cancel installation.  
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7. Installation starts and dialog showing a progress of installation is displayed.  

When installation is complete the dialog "Installation Complete" is displayed. 

 

 
 

Click button "Close" to complete installation.  

Now you may open "Start" menu and find menu item "Breeze".  

To start working with Breeze, open "Breeze" menu and then click sub item "Breeze".  

Another way to start Breeze is to open computer "Desktop", find Breeze icon and 
click it. 
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Uninstall the Breeze 

 

Breeze package can be uninstalled via the standard Windows dialog "Add or Remove 
Programs" or via the item in the Breeze menu "Uninstall or Repair Breeze". 

 

Uninstall Breeze via the Windows control "Add Remove Programs" 

 

To open dialog "Add or Remove Programs" click "Start" menu, and then item "Control 
Panel" in the opened "Start" menu.  

In the Control Panel select and click item "Add or Remove Programs". Dialog "Add or 
Remove Programs" will open.  

Select in the list of installed programs item "Breeze". To verify that selected item is 
correct, click link "Click here for support information". In opened window "Support 
info" item "Publisher" should be "Discovery Scientific, LLC".  

To start uninstall process click button "Remove".  

Click button "Yes" in the dialog asking "Are you sure you want to remove Breeze 
from you computer?" if you are sure to do that. Click button "No" if you are not sure.  

If button "Yes" has been clicked then Windows open dialog with horizontal progress 
bar indicating a state of uninstall process. Dialog will be closed after uninstall process 
is completed. 
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Uninstall Breeze via the item "Uninstall or Repair Breeze" in the Start menu 

 

To start uninstall process click "Start" menu and then item "All Programs".  

In open "All Programs" menu list select menu item "Breeze, and then sub item 
"Uninstall or Repair Breeze". Windows will open dialog "Welcome to the Breeze Setup 
Wizard". 

 

 
 

Click radio button "Remove Breeze".  

If you are not sure that you want to uninstall Breeze then click button "Cancel" and 
uninstall process will be stopped.  

If you are sure that you want to uninstall Breeze then click button "Finish".  
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If button "Finish" has been clicked then Windows open dialog with horizontal 
progress bar indicating a state of uninstall process. Dialog will be closed after 
uninstall process is completed. 

 

 

116 

Copyright ©2008 · Discovery Scientific, LLC  
 



Install/Uninstall                                                                                         Breeze Getting Started Guide 
 

Repair the Breeze 

If some components of Breeze package were accidentally removed or damaged, then 
integrity of the package and all its components can be repaired. Breeze package can 
be repaired via the standard Windows dialog "Add or Remove Programs" or via the 
item in the Breeze menu "Uninstall or Repair Breeze". 

 

Repair Breeze via Windows control "Add Remove Programs" 

To open dialog "Add or Remove Programs" click "Start" menu, and then item "Control 
Panel" in the opened "Start" menu.  

In the Control Panel select and click item "Add or Remove Programs". Dialog "Add or 
Remove Programs" will open.  

Select in the list of installed programs item "Breeze". To verify that selected item is 
correct, click link "Click here for support information". In opened window "Support 
info" item "Publisher" should be "Discovery Scientific, LLC".  

To start repair process click button "Change". Windows open dialog "Welcome to the 
Breeze Setup Wizard".  

Click radio button "Repair Breeze".  

If you are not sure that you want to repair Breeze then click button "Cancel" and 
repair process will be stopped.  

If you are sure that you want to repair Breeze then click button "Finish".  

If button "Finish" has been clicked then Windows open dialog with horizontal 
progress bar indicating a state of repair process. Dialog will be closed after repair 
process is completed. 
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Repair Breeze via item "Uninstall Breeze" in the Start menu 

To start repair process click "Start" menu and then item "All Programs".  

In open "All Programs" menu list select menu item "Breeze, and then sub item 
"Uninstall or Repair Breeze". Windows open dialog "Welcome to the Breeze Setup 
Wizard". 

 
Click radio button "Repair Breeze".  

If you are not sure that you want to repair Breeze then click button "Cancel" and 
repair process will be stopped.  

If you are sure that you want to repair Breeze then click button "Finish".  

If button "Finish" has been clicked then Windows open dialog with horizontal 
progress bar indicating a state of repair process. Dialog will be closed after repair 
process is completed. 
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Activate the Breeze 

 

 
 

This dialog allows you to activate Breeze.  

Commercial Breeze software packages include 30 days trial evaluation period.  

Evaluation period starts immediately after installing software. During this period 
functionality of software is same as in the activated software. To continue using 
software after evaluation period expires, software has to be activated with a License 
key.  

License key for downloaded software can be purchased on-line at the 
www.DiscoveryBiz.Net (see item "Purchase" in the menu).  

Activation license key is issued immediately after purchasing a product.  

Subscription access key for packages with 12 months subscription for free download 
upgrades, is issued immediately after purchasing a product.  

Retail packages include product certificate where license key can be found.  

After license key is obtained, Breeze can be activated. During evaluation period 
"About" dialog box shows button "Activate". Click this button to open the activation 
dialog. Enter license key in the activation dialog and then press button "Submit". 
Please, enter to the edit boxes only digits and letters of license key; do not enter 
dashes.  

Before activation "About" dialog displays text information showing how many days 
are left for the trial evaluation. "About" dialog displays activation license key after 
successful activation. Button "Activate" is not shown in the "About" dialog box after 
activation. 
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9. Breeze license 
 

Single User License Agreement 

 

Breeze Software ® 

 

Discovery Scientific, LLC 

 

IMPORTANT-READ CAREFULLY: This End-User License Agreement ("Agreement") is a legal 
contract between you (either (a) an individual user or (b) a business organization ("you") and 
Licensor (as designated below) for the Breeze software, including any associated media, 
printed materials and electronic documentation (the "Software").  

THE USE OF THIS SOFTWARE IS SUBJECT TO THE SOFTWARE LICENSE TERMS OF DISCOVERY 
SCIENTIFIC, LLC AND OTHER LICENSORS, WHOSE SOFTWARE MAY BE BUNDLED WITH THIS 
PRODUCT. BY YOUR USE OF THE SOFTWARE INCLUDED WITH THIS PRODUCT YOU AGREE TO 
THE LICENSE TERMS REQUIRED BY THE LICENSOR OF THAT SOFTWARE, AS SET FORTH 
BELOW. 

By clicking on the "Yes" ( "I ACCEPT", "I AGREE", etc.) button, by opening the package that 
contains the Software, or by copying, downloading, accessing or otherwise using the Software, 
you agree to be bound by the terms of this Agreement and you represent that you are 
authorized to enter into this Agreement on behalf of your corporate entity (if applicable). If you 
do not wish to be bound by the terms of this Agreement, click the "No" ("I DO NOT ACCEPT", 
"DO NOT AGREE, etc.) button, and do not install, access or use the Software.  

IF YOU DO NOT AGREE TO THE LICENSE TERMS APPLICABLE TO THE SOFTWARE, YOU MAY 
RETURN THE ENTIRE UNUSED PRODUCT TO THE SOURCE FROM WHICH YOU OBTAINED IT. 

As used herein, "Licensor" and "Discovery Scientific" mean Discovery Scientific, LLC, Delaware 
USA Company  

RETURN AND REFUND POLICY 

Discovery Scientific does not permit the return of or offer refunds for the following products:  

1. Retail software in the open box with destroyed original seal  

2. Electronic software downloads  

An original purchaser of retail (boxed) software, who has not accepted the terms of this 
Agreement, may return the Software to the place of purchase within 30 days of the date of 
purchase, for a refund. Please contact Discovery Scientific for details of return / refund at 
www.DiscoveryBiz.net or via e-mail Support@DiscoveryBiz.net.  

EVALUATION SOFTWARE 

If you have received the Software for purposes of evaluation, regardless of how labeled, the 
use of the Software is limited to a specified period of time, as detailed in the email 
accompanying the download instructions (the "Evaluation Period") and all use will be governed 
by the terms set forth below.  

1. Grant of License. Licensor grants you a limited, personal, internal use, non-exclusive, 
non-transferable license to use the Software solely to evaluate its suitability for your internal 
business requirements during the Evaluation Period. Without limiting the foregoing, you may 
not use the Software during the Evaluation Period to create publicly distributed computer 
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software or for any other commercial purpose. This license may be terminated by Licensor at 
any time upon notice to you and will automatically terminate, without notice, upon the first to 
occur of the following: (a) the completion of your evaluation of the Software or (b) the 
expiration of the Evaluation Period. 

2. Limited Use Software. Portions of the full-use version of the Software may be withheld or 
unusable and use of the Software may require accessing portions of the Software remotely 
through the Internet. Full use of the Software may be restricted by technological protections. 

3. Disclaimer of Warranty. THE SOFTWARE IS PROVIDED ONLY FOR EVALUATION 
PURPOSES ON AN "AS IS" BASIS. LICENSOR EXPRESSLY DISCLAIMS ALL WARRANTIES, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, AND NON-INFRINGEMENT. 

4. Limitation of Liability. IN NO EVENT WILL LICENSOR BE LIABLE FOR ANY DAMAGES, 
INCLUDING LOST PROFITS OR DATA, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR ANY DATA SUPPLIED 
THEREWITH, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 

 

SOFTWARE LICENSE 

In return for acquiring a license to use the Software, which may include software from third 
party licensors and patches made available by Software, and the related documentation, you 
agree to the following terms and conditions: 

1. License. 

This Agreement grants you, the Licensee, a license to:  

(a) use the Software on a single computer system, which is not intended for use by more than 
ten (10) users; and (b) make one copy of the Software in machine readable form solely for 
back-up purposes, provided you reproduce copyright proprietary legends of Licensor. 
Notwithstanding the foregoing, the Software may be used on the home, laptop or other 
secondary computer of the principal user of the Software, and an additional copy of the 
Software may be made to support such use. As used in this license, the Software is "in use" 
when it is either loaded into RAM or installed on a hard disk or other permanent memory 
device. The Software may be "in use" on only one computer at any given time. (Different 
license terms and fees are applicable for networked or multiple user applications.) As a specific 
condition of this license, you agree to use the Software in compliance with all applicable laws, 
including copyright laws, and that you will not copy, transmit, perform or distribute any audio 
or other content using the Software without obtaining all necessary licenses or permissions 
from the owner of the content. 

 

2. Restrictions. 

You may not distribute copies of the Software to others (including distribution on the Internet) 
or electronically transfer the Software from one computer to another over a network. You may 
not post or otherwise make available the Software, or any portion thereof, in any form, on the 
Internet. You may not use the Software in a computer service business, including in time 
sharing applications. The Software contains trade secrets and, in order to protect them, you 
may not decompile, reverse engineer, disassemble, or otherwise reduce the Software to a 
human-perceivable form. YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, LOAN, 
RESELL FOR PROFIT, DISTRIBUTE, NETWORK OR CREATE DERIVATIVE WORKS BASED UPON 
THE SOFTWARE OR ANY PART THEREOF.  
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3. Ownership of Software.  

As Licensee, you own the media upon which the software is recorded or fixed, but Licensor and 
its licensors retain title and ownership of the Software recorded on the original media and all 
subsequent copies of the Software, regardless of the form or media in which or on which the 
original and other copies may exist. This license is not a sale of the Software or any copy. 

4. Confidentiality.  

You agree to maintain the Software in confidence and that you will not disclose the Software to 
any third party without the express written consent of Licensor. You further agree to take all 
reasonable precautions to preclude access of unauthorized persons to the Software. 

5. Term.  

This license is effective until January 1, 2050, unless terminated earlier. You may terminate the 
license at any time by destroying the Software (including the related documentation) together 
with all copies or modifications in any form. Licensor will have the right to terminate our license 
immediately if you fail to comply with any term or condition of this Agreement. Upon any 
termination, including termination by you, you must destroy the Software (including the related 
documentation), together with all copies or modifications in any form. 

6. Special Terms Applicable to Additional Tools and Databases. 

Where an additional tool or database is included with the Software, you acknowledge that it is 
licensed only in connection with the use of the Software to perform operations implemented by 
the "main" executable of Software, and that the additional tool or database and all data derived 
there from must be maintained in confidence in accordance with the provisions of Section 4. 
This license does not grant you any rights to distribute or disclose such tool or database or 
data. 

7. Limited Warranty.  

Licensor and its licensors warrant only that the Software will perform substantially in 
accordance with the accompanying written documentation for a period of thirty (30) days from 
the date of your Software purchase receipt. LICENSOR AND IT LICENSORS DO NOT AND 
CANNOT WARRANT THE RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR 
DOCUMENTATION. THE FOREGOING STATES THE SOLE AND EXCLUSIVE REMEDIES LICENSOR 
OR ITS LICENSORS WILL PROVIDE FOR BREACH OF WARRANTY. EXCEPT FOR THE FOREGOING 
LIMITED WARRANTY, LICENSOR MAKES NO WARRANTIES, EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED, AS TO NON-INFRINGEMENT OF THIRD PARTY RIGHTS, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow the 
exclusion of implied warranties or limitations on how long an implied warranty may last, so the 
above limitations may not apply to you. This warranty gives you specific legal rights and you 
may also have other rights which vary from state to state. 

The entire liability of Licensor and its licensors, and your exclusive remedy for a breach of this 
warranty, shall be: (a) the replacement of the Software not meeting the above limited warranty 
which is returned to Licensor; or (b) if Licensor or its distributor is unable to deliver 
replacement Software, you may terminate this Agreement by returning the Software and your 
money will be refunded. 

8. Limitation of Liability.  

IN NO EVENT WILL LICENSOR OR ITS LICENSORS BE LIABLE TO YOU FOR ANY INCIDENTAL, 
CONSEQUENTIAL OR INDIRECT DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, 
OR LOSS OF DATA, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. Some states do not allow the exclusion 
or limitation of special, incidental, or consequential damages, so the above limitation or 
exclusion may not apply to you. 
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9. General.  

You acknowledge that you have read this Agreement, understand it, and that by using the 
Software you agree to be bound by its terms and conditions. You further agree that it is the 
complete and exclusive statement of the agreement between Licensor and you, and supersedes 
any proposal or prior agreement, oral or written, and any other communication between 
Licensor and you relating to the subject matter of this Agreement. No additional or any 
different terms will be enforceable against Licensor unless Licensor gives its express consent, 
including an express waiver of the terms of this Agreement, in writing signed by an officer of 
Licensor. You assume full responsibility for the use of the Software and agree to use the 
Software legally and responsibly. This Agreement shall be governed by the law of state 
Delaware, except as to copyright matters, which are covered by Federal law. This Agreement is 
deemed entered into at Wilmington, Delaware, USA by both parties. Should any provision of 
this Agreement be declared unenforceable in any jurisdiction, then such provision shall be 
deemed severable from this Agreement and shall not affect the remainder hereof. All rights in 
the Software not specifically granted in this Agreement are reserved by Licensor. 
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